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Important Notice and Safety Instructions

Important Note

You may use the software to operate the EPSON products. You may use the EPSON 
PP-100III/PP-50II to copy materials onto media, including but not limited to CDs, DVDs, and BDs. 
You agree to respect the rights of copyright owners. EPSON shall have no liability for, and you 
shall hold EPSON harmless from, any copyright infringement by you or your employees, 
representatives, or agents.

Important Safety Instructions

Read all the instructions in this section before using the product. Also, be sure to follow all 
warnings and instructions marked on the product.

Setting up the Product

Observe the following when setting up the product:

❏ Do not block or cover the vents and openings in the product.

❏ Use only the type of power source indicated on the product’s label.

❏ Use only the power cord that comes with the product. Use of another cord may result in fire 
or electric shock.

❏ The product’s power cord is for use with this product only. Use with other equipment may 
result in fire or electric shock.

❏ Be sure the AC power cord meets the relevant local safety standard.

❏ For safety reasons, make sure to ground the power cord.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that regularly 
switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.
Important Notice and Safety Instructions 8



❏ Keep the entire computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or the base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the product, make sure that the total ampere rating of the 
devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, 
make sure that the total ampere rating of all devices plugged into the wall outlet does not 
exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the product yourself.

❏ Unplug the product and refer servicing to qualified service personnel under the following 
conditions:
The power cord or plug is damaged; liquid has entered the product; the product has been 
dropped or the casing is damaged; the product does not operate normally or exhibits a 
distinct change in performance.

❏ If you plan to use the product in Germany, the building installation must be protected by a 
10 or 16 amp circuit breaker to provide adequate short-circuit protection and over-current 
protection for the product.

❏ When connecting the product to a computer or other device with a cable, ensure the correct 
orientation of the connectors. Each connector has only one correct orientation. Inserting a 
connector in the wrong orientation may damage both devices connected by the cable.

❏ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there 
are fuses in the plug, make sure you replace them with fuses of the correct size and rating.

❏ Do not put any heavy object or load on the product. Excessive loads can cause a malfunction. 
However, for the PP-100III and PP-100AP, it is possible to place one unit of this product on 
top of another. In such a case, make sure the tops and bottoms are oriented the same, and 
the exterior of the units are aligned. At the same time, take sufficient care to prevent a unit 
from dropping or falling. Also, do not place more than one unit on top of another.

❏ Only for the PP-100III: Be sure to install the specified ones when you replace drives of the 
product.

❏ Only for the PP-50II: Commercially available replacement drives do not function on this 
product.

Choosing a Place for the Product

Observe the following when choosing a place for the product:
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❏ Place the product on a flat, stable surface that extends beyond the base of the product in all 
directions. If you place the product by the wall, leave more than 10 cm (3.94") between the 
back of the product and the wall. The product will not operate properly if it is tilted at an 
angle.

❏ Leave enough space in front of the product for the disc cover to be fully opened.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the product 
away from direct sunlight, strong light, or heat sources.

❏ Avoid places subject to dust, shocks, vibrations, or cigarette smoke.

❏ Leave enough room around the product to allow for sufficient ventilation.

❏ Place the product near a wall outlet where the plug can be easily unplugged.

Using the Product

Observe the following when using the product:

❏ Do not insert objects in the product.

❏ Take care not to spill liquid on the product.

❏ Do not use aerosol products that contain flammable gases inside or around this product. 
Doing so may cause fire.

❏ Always turn the product off using the P power button. When this button is pressed, the  
power light flashes. Do not unplug the product or turn off the power to the outlet until the 

 power light stops flashing.

❏ Leave the ink cartridges installed. Removing the cartridges can dry out the print head and 
may prevent the product from printing.

❏ Be careful not to trap your fingers when closing the disc cover.

❏ The product uses galvanized sheet metal, and this may cause rusting at the edges; however, 
this does not cause any harm to the function of the product.

❏ Do not place any drink or liquid on the product as penetration by liquid inside the product 
will cause a malfunction.

❏ The product cannot be used as a shared printer using the Windows sharing setting.
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Handling Ink Cartridges

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink from or handle 
the cartridges.

❏ Do not shake ink cartridges; this can cause leakage.

❏ Be careful when you handle used ink cartridges, as there may be some ink remaining around 
the ink supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If 
ink gets into your eyes, flush them immediately with water. If discomfort or vision problems 
remain after a thorough flushing, see a doctor immediately.

❏ Do not remove or tear the label on the cartridge; this can cause leakage.

❏ Install the ink cartridge immediately after you remove it from its package. If you leave a 
cartridge unpacked for a long time before using it, normal printing may not be possible.

❏ Use the ink cartridge before the expiration date printed on its package.

❏ Do not dismantle ink cartridges or try to refill them. This could damage the print head.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Do not touch the green IC chip on the side of the cartridge. Doing so may prevent normal 
operation and printing.

❏ The IC chip on this ink cartridge retains a variety of cartridge-related information, such as the 
ink cartridge status, so that the cartridge may be removed and reinserted freely. However, 
each time the cartridge is inserted, some ink is consumed because the product automatically 
performs a reliability check.

❏ Do not place ink cartridges with the ink supply area facing down. This may result in ink 
leakage. Also, dirt attached to the ink supply area may result in the product not functioning 
properly.

Notice for CD/DVD/BD Discs

Before using the product, an operation check should be conducted to ensure the unit’s 
functionality. Also, back up the data on the CD/DVD/BD, if needed. Data may be damaged or lost 
in the following cases:
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-Influence of static or electrical noise
-Incorrect usage
-Malfunction or repair
-Damage due to natural disaster 

Epson does not hold any responsibility for lost or damaged data, due to causes not limited to 
those listed above, even the product is in its warranty period.

Concerning Incidental Loss Arising out of Use of this Product

Should the expected results from this product, including bundled software, not be obtained, we 
cannot compensate for incidental loss arising from that fact, such as expenses required for use of 
this product and lost earnings that would have been gained through the use of this product.

About Usage Limitation

❏ When this product is used for applications requiring high reliability / safety, such as 
transportation devices related to aviation, rail, marine, automotive, etc.; disaster prevention 
devices; various safety devices, etc.; or functional / precision devices, etc., you should use this 
product only after giving consideration to including fail-safes and redundancies into your 
design to maintain safety and total system reliability. Because this product was not intended 
for use in applications requiring extremely high reliability / safety, such as aerospace 
equipment, main communication equipment, nuclear power control equipment, or medical 
equipment related to direct medical care, etc., please make your own judgment on this 
product’s suitability after a full evaluation.

❏ When copying a CD, DVD, or BD, you must meet the conditions that the work recorded on 
the discs does not have a copyright, that you have a copyright for the work, that you have 
received permission from the author, or that copying of the work onto the discs is legally 
approved. Copying of a CD, DVD, or BD without meeting these conditions is illegal and 
should not be done.

❏ This product is for business use and not for household use.

Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User's Guide as indicated below have the following 
meanings.

w
Warnings
must be followed carefully to avoid bodily injury.
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c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the product.
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Chapter 1 

Using Your Software

System Requirements

Using the Product

Windows requirements

To use this product, you must have any of the following Windows operating systems installed.

Operating system Windows 10 (32 bit/64 bit)
Home/Pro/Enterprise

Windows 8.1 (32 bit/64 bit)
Windows 8.1 Pro (32 bit/64 bit)
Windows 8 (32 bit/64 bit)
Windows 8 Pro (32 bit/64 bit)
Windows 7 (32 bit/64 bit, SP1 or later)

Home Premium/Professional/Enterprise/Ultimate
Windows XP (32 bit, SP3 or later)

Home Edition/Professional
Windows Server 2019

Standard/Essentials
Windows Server 2016

Standard/Essentials
Windows Server 2012 R2 (64 bit)

Standard/Essentials
Windows Server 2012 (64 bit)

Standard/Essentials
Windows Server 2008 R2 (64 bit, SP1 or later)

Standard/Enterprise
Windows Server 2008 (32 bit/64 bit, SP2 or later)

Standard/Enterprise
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CPU Windows 10
Windows 8.1
Windows 8 
Windows 7
Windows XP

PP-100III/PP-50II: Core DuoT2700/Core2Duo E6300 or 
more (or compatible processor)
PP-100AP: Intel Pentium 4 (or compatible processor) 1.4 
GHz or faster processor

Windows Server 2019
Windows Server 2016
Windows Server 2012 R2
Windows Server 2012
Windows Server 2008 R2
Windows Server 2008

PP-100III/PP-50II: Core DuoT2700/Core2Duo E6300 or 
more (or compatible processor)
PP-100AP: Intel Pentium 4 (or compatible processor) 2.0 
GHz or faster processor

Memory Windows 10 64 bit 
Windows 8.1 64 bit
Windows 8 64 bit
Windows 7 64 bit
Windows Server 2019
Windows Server 2016
Windows Server 2012 R2
Windows Server 2012
Windows Server 2008 R2
Windows Server 2008

2 GB or more

Windows 10 32 bit
Windows 8.1 32 bit
Windows 8 32 bit
Windows 7 32 bit

1 GB or more

Windows XP PP-100III/PP-50II: 1 GB or more
PP-100AP: 512 MB or more

HDD 
available 
space

Windows 10 64 bit 
Windows 8.1 64 bit
Windows 8 64 bit
Windows 7 64 bit

PP-100III/PP-50II: 100 GB or more
PP-100AP: 30 GB or more

Windows 10 32 bit
Windows 8.1 32 bit
Windows 8 32 bit
Windows 7 32 bit

PP-100III/PP-50II: 100 GB or more
PP-100AP: 26 GB or more

Windows XP PP-100III/PP-50II: 100 GB or more
PP-100AP: 10 GB or more

Windows Server 2019
Windows Server 2016
Windows Server 2012 R2
Windows Server 2012

170 GB or more

Windows Server 2008 R2
Windows Server 2008

PP-100III/PP-50II: 100 GB or more
PP-100AP: 50 GB or more

HDD rotation speed 7200 rpm or faster
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Note:
❏ ATI South Bridge chip set IPX460 or earlier is incompatible with the PP-100III.

❏ Intel 5 Series chip set or earlier is incompatible with this product.

❏ Refer to the URLs listed on pages “Help for Users in the United States and Canada” on page 170 
and “Help for Users in the Europe (EMEA)” on page 170 for chip sets that are not supported.

❏ The product may not function properly where third party writing software is installed, anti-virus 
software is installed, or another USB device is connected.

❏ You cannot use the product with remote desk top function or virtual environment.

❏ Only for the PP-100III/PP-50II: 

❏ If your file system is FAT, you may not write to a DVD/BD.

❏ Use a CD/DVD drive that supports commands and operations compatible with MMC 4.0 or 
higher and can read subchannel data as a source drive for copying.

❏ Use a BD drive that supports commands and operations compatible with MMC 5.0 or higher 
and can read subchannel data as a source drive for copying.

❏ Only for the PP-100III: Use USB 3.0 standard compatible interface to ensure Super-Speed USB 
performance.

Screens and Procedures in This Guide

Depending on your model or environment, the screen shots used in this guide may differ from 
the actual screens displayed. However, you can still use the same procedures described in this 
guide.

Interface PP-100III: USB 2.0 or USB 3.0
PP-50II/PP-100AP: USB 2.0
❏ Compatible with USB 2.0 or USB 3.0 standard
❏ Ensure Hi-Speed USB or Super-Speed USB 

performance

Display XGA (1024 x 768 pixels) or higher
65,536 colors or more

Other Windows Media Player 6.4 or higher must be installed.
Only for the PP-100III/PP-50II: Creating music CDs requires 
a sound device with an appropriate driver installed.
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Setting a Working Folder and Log

After the software installation, create a Working Folder on the hard disk for the disc publishing 
operation. You can also set for log files. Log files are useful for service and support of the product.

Note:
These settings are reflected for all the CD/DVD/BD publishers registered (except for the PP-100N).

1. Select Start ( ) - All Programs - EPSON Total Disc Maker - EPSON Total Disc Setup.

The EPSON Total Disc Setup will start.

2. Select Common Setting for Publishing from the Tool menu.

The Common Setting for Publishing screen will appear.

3. Click Browse to select a folder to create a Working Folder.

Note:
Select a drive with sufficient free space. For information on the necessary HDD space, see the 
following section.
& See “System Requirements” on page 14.

4. Check the checkbox for Save publication log if you want to save the usage history of the 
product.

Note:
When the log files saved in the computer exceed 200MB, the older ones will be deleted (starting 
with the oldest one) to make room for new ones.

5. Click OK.
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Adding the Product

Use the EPSON Total Disc Setup to add the product (CD/DVD/BD publisher) to the computer.

Note:
The product must be added when the connection point (port) is set manually. However, the product 
does not need to be added when the connection point (port) is set automatically.

1. Make sure that the product is connected to the computer via the USB cable and that the 
product is turned on.

2. Select Start ( ) - All Programs - EPSON Total Disc Maker - EPSON Total Disc Setup.

The EPSON Total Disc Setup will start.

3. Click Add.

4. Select Local CD/DVD/BD publisher, and then click Next.

5. Select the product to be added from CD/DVD/BD Publisher List, then click Next.

6. Enter any name and click OK.
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Setting for Notification of Job Completion

You can make settings to display a message on the screen that notifies you that a job (or jobs) is 
finished. For the PP-100III and PP-100AP, you can also set a beep to notify you that the input 
stacker is empty.

Note:
This setting is reflected for all the CD/DVD/BD publishers registered.

1. Select Start ( ) - All Programs - EPSON Total Disc Maker - EPSON Total Disc Setup.

The EPSON Total Disc Setup will start.

2. Select Common Setting for Publishing from the Tool menu.

The Common Setting for Publishing screen will appear.

3. Click Notification Settings tab.

The Notification Settings screen will appear.

4. PP-100III/PP-100AP: Select either one or both of the options for Notification Method.
PP-50II: Check Display message box for Notification Method.

5. Select either one of the options for Notification when a job is finished.

6. Click OK.
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Overview of Applications

The EPSON Total Disc Maker software included with the product allows you to create disc labels 
and publish discs. For the PP-100III and PP-50II, it also allows you to write/copy discs or read data 
from discs.

EPSON Total Disc Maker

EPSON Total Disc Maker lets you write or copy discs and print disc labels. You can also read data 
from discs and store it in a HDD. The process used for these actions is called "Publish" in the 
EPSON Total Disc Maker program.

Note:
You can write/copy discs or read data from discs only with the PP-100III and PP-50II.

EPSON Total Disc Monitor

EPSON Total Disc Monitor is a utility that monitors the product and gives you information about 
its current status. Using EPSON Total Disc Monitor, you can also pause/cancel jobs or change the 
order of jobs to be processed.

EPSON Total Disc Setup

EPSON Total Disc Setup is a utility that allows you to register the product to the computer and to 
make basic settings for publishing discs, such as settings for publishing mode and stackers, as 
well as settings for drives for the PP-100III and PP-50II.
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Using EPSON Total Disc Maker

Use EPSON Total Disc Maker to do the following:

❏ Creating and editing disc labels.

❏ Only for the PP-100III/PP-50II: Writing data to BDs, data to DVDs, video to DVDs, data to CDs, 
music to CDs, music and data to CDs, or video to CDs, copying CD/DVDs/BDs, or reading back 
data in CDs/DVDs/BDs.

Starting EPSON Total Disc Maker

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

Getting Information through Online Help

You can access online help for EPSON Total Disc Maker from the software or from the Windows 
Start menu.

In window of EPSON Total Disc Maker, EPSON Total Disc Monitor, or EPSON Total Disc Setup, click 
the  button to display online help for each utility.
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Overview of Printer Driver

The printer driver lets you choose from a wide variety of settings to get the best printing results.

Accessing the Printer Driver

You can access the printer driver from EPSON Total Disc Maker, EPSON Total Disc Setup, most 
Windows-based applications, and the Windows Start menu.

If displayed from EPSON Total Disc Maker
The settings are only reflected in EPSON Total Disc Maker. The settings are lost when you exit 
EPSON Total Disc Maker.

If displayed from EPSON Total Disc Setup or the Start menu
The information you set is saved as the printer driver settings, and after this, it is reflected in the 
printer settings for EPSON Total Disc Maker and all other applications.

Refer to the following sections to access the printer driver.

From EPSON Total Disc Maker

1. Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click 
EPSON Total Disc Maker.

2. Select Print Settings from Tool menu.

From EPSON Total Disc Setup

1. Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click 
EPSON Total Disc Setup.

2. Select CD/DVD/BD Publisher, and then click Properties.

From Windows applications

1. Click Print or Print Setup in the File menu.

2. In the window that appears, click Printer, Setup, Options, Preferences, or Properties. 
(Depending on your application, you may need to click one or a combination of these 
buttons.) 

From the Start menu
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1. Click Start ( ), Control Panel, then Devices and Printers.

2. Right-click EPSON PP-XXXPRN, then click Printing Preferences in the menu.

"XXX" indicates the following depending on your model.

❏ For PP-100III: 100

❏ For PP-50II: 50

❏ For PP-100AP: 100AP

Getting Information through Online Help

You can access online help for items in the printer driver from your application or from the 
Windows Start menu.
& See “Accessing the Printer Driver” on page 22.

In the printer driver window, try one of the following procedures.

❏ Right-click the item, then select Help.

❏ Click Help.
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Uninstalling Software

You can uninstall the software by following the steps below.

Note:
❏ You may be asked for an administrator password or confirmation when uninstalling the 

software. When asked for a password, enter the password to proceed with the operation.

❏ In Windows XP, log onto Windows as a user with administrator privileges (belonging to the 
administrator group) to uninstall the software.

❏ When installing the software, various Microsoft components may be installed. Some of them may 
not be uninstalled when uninstalling the software.

1. Close all applications.

2. Click Start ( ), and then select Control Panel.

3. Click Uninstall a program.

4. Choose EPSON Total Disc Maker, and then click Uninstall.

Note:
If you cannot perform the uninstallation due to any problem, uninstall the software by 
double-clicking setup.exe in Discproducer Utility & Documents Disc.

5. When the confirmation message appears, click Yes.

6. Follow the on-screen instructions.
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Chapter 2 

Publishing Discs

Introduction

This section guides you through the procedures for creating, printing, and reading discs.

Note:
For information on discs, see the following section.
& See “Discs” on page 183.

Turning Power On/off

This section describes how to turn on/off power.

Turning power on

1. Connect the power cable.

2. Press P Power button until the power light flashes.

Power light flashes in green, then stays on.

Turning power off

Press the P Power button. The Power light will flash in green then turn off; then power is 
turned off.

c
Caution:
❏ Fan will operate after turning power off, but it will automatically stop after 15 minutes.

❏ If the product is operating, wait for 10 seconds after operation is stopped, then turn off 
power.

❏ The product may not be recognized by the computer when the power is turned back on 
while fan is operating. In this case, disconnect the USB cable and connect it again.

Note:
Only for the PP-100III/PP-50II: If turning off the product while power on the PC is on, follow the 
procedure below. If the product is turned off without following the procedure, data in the PC maybe 
damaged.
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1. If Total Disc Maker, Total Disc Monitor, or Total Disc Setup is running, close the software.
2. Double click "Safely Remove Hardware" on the task tray.
3. Select a drive on the product and select Stop.

Overview of Publish Modes

Writing data to discs, printing labels that you created/edited, and reading data from discs are 
called “Publish” in EPSON Total Disc Maker.

Standard Mode (for PP-100III/PP-100AP)

This mode uses stacker 1 as the input stacker, and stacker 2, 3, or 4 as the output stacker.

When stacker 2 or 3 is selected as the output stacker, up to 50 discs can be created at once. Also, 
if you refill discs in the input stacker and take out published discs from the output stacker at the 
same time, up to 1000 discs can be published in a single job. 

If stacker 4 is selected as the output stacker, discs can be removed without stopping the product 
while running a job.

& See “Standard Mode (For PP-100III/PP-100AP)” on page 34.

Standard Mode (for PP-50II)

This mode uses stacker 1 as the input stacker, and stacker 2 or 3 as the output stacker.

When stacker 2 is selected as the output stacker, up to 50 discs can be created at once. Also, if 
you refill discs in the input stacker and take out published discs from the output stacker at the 
same time, up to 1000 discs can be published in a single job.

& See “Standard Mode (For PP-50II)” on page 47.

External Output Mode (for PP-100III/PP-100AP)

This mode uses stacker 1 and 2 as the input stackers, and stacker 3 or 4 as the output stacker.

Different types of discs (CD, DVD, or BD) can be loaded into each of the 2 stackers and can create 
different types of discs. This is ideal for creating small batches of discs at once.

If the same type of discs are loaded into stacker 1 and 2 and Auto is selected for the input stacker 
setting, up to 100 discs can be continuously published by taking out published discs without 
refilling discs.

Up to 1000 discs can be continuously published in a single job by refilling discs and taking out 
published discs.
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If stacker 4 is selected as the output stacker, discs can be removed without stopping the product 
while running a job.

Note:
This mode does not use stacker 3 if you select stacker 4 as the output stacker.

& See “External Output Mode (For PP-100III/PP-100AP)” on page 59.

Low-Volume Mode (for PP-50II)

This mode uses stacker 1 and 2 as the input stackers, and stacker 3 as the output stacker.

Different types of discs (CD, DVD, or BD) can be loaded into each of the 2 stackers and can create 
different types of discs. This is ideal for creating small batches of discs at once.

If the same type of discs are loaded into stacker 1 and 2 and Auto is selected for the input stacker 
setting, up to 100 discs can be continuously published by taking out published discs without 
refilling discs.

Up to 1000 discs can be continuously published in a single job by refilling discs and taking out 
published discs.

& See “Low-Volume Mode (For PP-50II)” on page 73.

Batch Mode (for PP-100III/PP-100AP)

This mode uses stacker 1 and 2 as the input stackers, and stacker 2 and 3 as the output stackers. 

You can create up to 100 discs at once without refilling and taking out discs while publishing. Up 
to 1000 discs can be continuously published in a single job by refilling discs and taking out 
published discs. To use this mode, you need to place stacker 3 into the product.

& See “Batch Mode (For PP-100III/PP-100AP)” on page 86.

Read Back Mode (for PP-100III/PP-50II)

This mode uses stacker 1 as the input stacker, and stacker 2 as the output stacker.

Data in up to 50 discs in stacker 1 can be read at once. You can store the data in your 
local/network HDD as files or a disc image file.

& See “Read Back Mode (For PP-100III)” on page 100 or “Read Back Mode (For PP-50II)” on page 
110.
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Drive Settings (Only for PP-100III/PP-50II)

Drive to be used (Only for PP-100III)

Select Drive to Use from the following.

Use Both

Use both drive 1 and 2 to write/read data. Jobs will be efficiently processed by using 2 drives. If 
trouble occurrs on either drive and it cannot write data, other drive will be used automatically.

Use Drive 1 Only

Use only drive 1.

Use Drive 2 Only

Use only drive 2.

Number of write retries (except for Read Back mode)

Select 0 to 9 for the Number of write retries.

The Number of write retries is a setting to retry writing if a write error occurs.

Setting the Number of write retries will enable the job to continue without pausing if a write 
error occurs.

No. of read back errors allowed (only for Read Back mode)

Select 0 to 9 for the No. of read back errors allowed.

Setting the No. of read back errors allowed will enable jobs to continue without pausing until the 
set number of read back errors continuously occur. When a read back error occurs, the disc will 
be ejected as an error disc and reading the next disc will be processed.

Continue publishing regardless of the occurrence of read back errors (only for Read 
Back mode)

If you check this checkbox, no matter how many times a read back error occurs, the jobs will 
continue without pausing. When a read back error occurs, disc will be ejected as an error disc 
and reading the next disc will be processed.
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Printer Settings

Printer name

Select Printer Name.

Note:
When changing the printer name, do not use Unicode characters. The device will not be recognized 
correctly.

Failure error mark (only for PP-100III/PP-50II)

If you check this checkbox, an error mark will be printed on any disc with a write error. This is 
useful to identify the disc which encountered the write error.

Note:
The error mark will not be printed in the following cases.

❏ The job was canceled

❏ An incorrect disc type was found in the stacker

❏ Fatal error

❏ Not enough ink was left to print the error mark

Notice for Disc Writing and Printing

❏ Store the stacker out of direct sunlight. A warped or damaged stacker may stop the product 
from operating normally.

❏ Use only discs labeled as suitable for printing, for example “Printable on the label surface” or 
“Printable with ink jet printers.”

❏ For more details on handling discs and for guidelines for writing data to discs, refer to your 
CD/DVD/BD documentation.

❏ When using the product for the first time after storing it for a long time or after an error, 
missing dots or ink stains may appear and print quality may be reduced. If publishing a large 
number of discs, check print quality by publishing one disc in advance. If any dots are 
missing, run head cleaning.

❏ Printing on rib area may result in ink sticking, disc sticking, or color loss.
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❏ Try to test print on a spare disc, and check the printed surface after waiting for one full day, 
especially before printing a large number of discs.

❏ After printing the first copy, check the print quality to see if any dots are missing.

❏ Before using or touching the printed surface of your discs, make sure they are completely dry 
and keep them out of direct sunlight.

❏ If the printed surface is sticky even after it has dried, do the following.
1. Change label type.
2. Change color saturation level.
3. Change the disc.

❏ Moisture on the printable surface may cause smearing.

❏ If you print on the matte label type of Epson specified CDs, set Label Type to CD/DVD Label.

❏ If you print on the matte label type of Epson specified DVDs, set Label Type to CD/DVD 
Premium Label.

❏ When using Epson specified discs, only [1] can be selected for Print Mode setting.

❏ Reprinting on the same disc may not improve the print quality.

❏ Be sure to clean the inside of the stacker before using it if there is any dirt.

❏ Please check disc before printing, as the size of the receptor may vary.

❏ Ink may not bond if printed outside the receptor.

❏ If the product is operating, wait for 10 seconds after the operation is finished, and then turn 
the power off.

❏ The quality of the blank disc determines print and write/read quality. It is recommended to 
use only the specified disc type.

❏ Do not use a cracked, warped, or deformed disc because it may break in pieces inside the 
product and cause malfunction or injury.

❏ A disc may become unreadable or unwritable if it has a small scratch or dirt; therefore, please 
handle it with care. 

❏ Hold disc by the edge, and do not touch either surface.

❏ The completed job display of EPSON Total Disc Monitor shows the number of successes, 
number of failures, and number of discs printed.
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❏ Do not use discs with lens cleaner, a label sticker, or condensation on them as it may cause 
mechanical error or malfunction.

❏ Only for the PP-100III/PP-50II: 

❏ When writing and printing discs separately, it is recommended to print after writing. If 
you write discs after printing, ink may cause discs to stick to each other and result in a 
transport error, or dirt, stains, or scratches on the disc may cause a write error.

❏ Data may be lost depending on the disc or storing condition; therefore, store important 
data on multiple discs. Epson does not guarantee the data against loss.

❏ Do not insert an object like a screwdriver or clip into the drive slots as this may cause a 
malfunction.

❏ A published CD/DVD/BD may not be readable on another type of drive or player due to 
compatibility.

❏ It is recommended that you run a compare while writing data.

❏ Making a backup is recommended if the data is important. Recorded data may degrade 
over long storing periods. It is recommended to make backups periodically.

❏ Do not shock or vibrate the product while reading or writing, as this may result in 
malfunction of the drive or make the disc unusable.

❏ If the file system of the computer used is FAT, DVD/BD writing may not be possible.

❏ Only for the PP-100III: Do not insert a disc between drive 1 and drive 2, as you may not be 
able to remove it.

Error Discs (Only for PP-100III/PP-50II)

For the PP-50II, discs with write/read error will be ejected to stacker 3.

For the PP-100III, discs with write/read error will be ejected to different stackers depending on 
the output stacker.

❏ When stacker 2 is set as the output stacker: 
Ejected to stacker 3 (when stacker 3 is used) or stacker 4 (when stacker 3 is not used).

❏ When stacker 3 is set as the output stacker:
Ejected to stacker 3.

❏ When stacker 4 is set as the output stacker:
Ejected to stacker 4.
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Note:
You can print an error mark on any disc with a write error to identify error discs.
& See “Failure error mark (only for PP-100III/PP-50II)” on page 29.

Precautions for Duplicating Discs (Only for PP-100III/PP-50II)

❏ Use a CD/DVD drive that supports MMC 4.0-compatible commands and operates in 
conformity with MMC 4.0 as a source drive for copying. (Please check the Epson website for 
a list of drives for which operation has been verified.)

❏ Use a BD drive that supports MMC 5.0-compatible commands and operates in conformity 
with MMC 5.0 as a source drive for copying. (Please check the Epson website for a list of drives 
for which operation has been verified.)

❏ Copying CDs/DVDs/BDs may not be possible depending on the type of CD/DVD/BD source 
drive used. If problems occur, please try using a different CD/DVD/BD source drive for 
copying.

❏ If the source disc is a multi-session CD/DVD/BD, it cannot be copied.

❏ If the source disc is a packet-written CD, it cannot be copied.

Printing on Discs with a Commercially Available Software Package

When you print on discs with a commercially available software package that supports disc 
printing, you have to make the following settings.

Notice for Barcode Printing

❏ When printing barcodes and 2D codes, be sure to use Epson brand ink cartridges.

❏ When printing barcodes and 2D codes on discs that are not Epson specified discs, check 
whether the printed barcodes or 2D codes can be read correctly by a scanner.

❏ Do not place barcodes or 2D codes where they overlap other print data, or where they 
extend beyond the print area.

Size 124 x 124 mm (4.88 x 4.88")

Type CD/DVD Label, CD/DVD Premium Label, or Epson Specified 
CD/DVD Label

Margins on all sides 2 mm (0.08")
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❏ Barcodes and 2D codes use the ratio of black to white to indicate information. If ink 
penetration results in a deterioration of the ratio of black to white, barcodes and 2D codes 
may not be able to be read correctly. Check whether the printed barcodes and 2D codes can 
be read correctly by a scanner.

❏ If a barcode printed with bidirectional printing cannot be read correctly, align the print head 
and then print the barcode, or print the barcode with unidirectional printing.
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Standard Mode (For PP-100III/PP-100AP)

Loading Discs

Follow the steps below to load discs.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. If you use stacker 3 for the following cases, insert stacker 3.

❏ When you select stacker 3 as the output stacker.

❏ When you select stacker 2 as the output stacker and you want to eject error discs to 
stacker 3 for the PP-100III.

c
Caution:
❏ Make sure that there are no discs in stackers 3 and 4.

❏ Do not pull out stacker 4. Be sure to lock the lock lever located on stacker 4.

7. If you select stacker 4 as the output stacker, unlock the lock lever located on stacker 4.
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8. Close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stacker, access EPSON Total Disc Maker by following the instructions 
below to make settings for writing discs (only for the PP-100III) and create labels for the discs.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.

Registering Data (Only for PP-100III)

The following instructions explain how to register data to be written on discs.

1. Start EPSON Total Disc Maker.
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2. Select type of discs to be published from the list, then click Apply.
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3. Drag and drop files or folders to the data tree or data list. For details, see Help for EPSON Total 
Disc Maker.

Note:
❏ Clicking Auto Insert Data... enables you to set for Merge data and burn. For details, see Help for 

EPSON Total Disc Maker.

❏ To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Creating Labels

The following instructions explain how to create labels using templates provided with the 
software.

1. Click Label on the menu bar of EPSON Total Disc Maker.
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2. Click Template tab and select a label design from the list, then click Apply.
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3. Make changes on the label as needed in the Background, Edit Item, and Layout tabs. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Making the Stacker Settings

The following instructions explain how to set stackers.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
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3. Set Stacker Settings.

❏ For the PP-100III

Publish Mode: Select Standard mode.

Stacker 1: Select the type of discs that you loaded into stacker 1.

Stacker 3: If you want to eject published discs to stacker 2 and error discs 
to stacker 3, select Use.

If you want to eject published discs to stacker 2 and error discs 
to stacker 4, select Do not use.

If you want to eject published discs to stacker 3, select Use.

If you want to eject published discs to stacker 4, select Do not 
use.

❏ For the PP-100AP

Publish Mode: Select Standard mode.

Stacker 3: If you want to eject published discs to stacker 3, select Use.

If you want to eject published discs to stacker 4, select Do not 
use.
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4. Click OK.

Publishing Discs

The following instructions explain how to publish discs.

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For details, see 
Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.

2. Click the Publish button.

The published discs are output to stacker 2, stacker 3, or stacker 4 according to your setting.
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c
Caution:
❏ Do not open the disc cover, maintenance box cover, and ink cartridge cover while a job is 

being processed (while the Busy light is flashing). This could adversely affect the writing or 
printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job may be resumed when Windows 
restarts next time.

❏ Only for the PP-100III: 

❏ Depending on the disc or the computer used, writing speed may become slower than 
the set speed.

❏ Depending on the disc used, the recommended writing speed of the disc cannot be 
used. In this case, reduce the writing speed. Especially with DVD±R DL and BD-R DL, it is 
recommended to write with slow speed.
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Standard Mode (For PP-50II)

Loading Discs

Follow the steps below to load discs.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. Close the disc cover.

c
Caution:
Before closing the disc cover, make sure that there is no disc left near stacker 3 and that discs in 
stacker 3 are not slanted. Otherwise, an error may occur when you close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stacker, access EPSON Total Disc Maker by following the instructions 
below to make settings for writing discs and create labels for the discs.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.

Registering Data

The following instructions explain how to register data to be written on discs.

1. Start EPSON Total Disc Maker.
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2. Select type of discs to be published from the list, then click Apply.
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3. Drag and drop files or folders to the data tree or data list. For details, see Help for EPSON Total 
Disc Maker.

Note:
❏ Clicking Auto Insert Data... enables you to set for Merge data and burn. For details, see Help for 

EPSON Total Disc Maker.

❏ To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Creating Labels

The following instructions explain how to create labels using templates provided with the 
software.

1. Click Label on the menu bar of EPSON Total Disc Maker.
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2. Click Template tab and select a label design from the list, then click Apply.
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3. Make changes on the label as needed in the Background, Edit Item, and Layout tabs. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Making the Stacker Settings

The following instructions explain how to set stackers.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
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3. Set Stacker Settings.

❏ Publish Mode: Select Standard mode.

❏ Stacker 1: Select the type of discs that you loaded into stacker 1.

4. Click OK.
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Publishing Discs

The following instructions explain how to publish discs.

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For details, see 
Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.

2. Click the Publish button.

The published discs are output to stacker 2 or stacker 3 according to your setting.
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c
Caution:
❏ Do not open the disc cover and ink cartridge cover while a job is being processed (while the 

Busy light is flashing). This could adversely affect the writing or printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job may be resumed when Windows 
restarts next time.

❏ Depending on the disc or the computer used, writing speed may become slower than the set 
speed.

❏ Depending on the disc used, the recommended writing speed of the disc cannot be used. In 
this case, reduce the writing speed. Especially with DVD±R DL and BD-R DL, it is 
recommended to write with slow speed.
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External Output Mode (For PP-100III/PP-100AP)

Loading Discs

Follow the steps below to load discs.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. Take out stacker 2.

7. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the disc.

8. Load discs into stacker 2 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.
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9. Insert stacker 2.

10. If you select stacker 3 as the output stacker, insert stacker 3.

c
Caution:
❏ Make sure that there are no discs in stackers 3 and 4.

❏ Do not pull out stacker 4. Be sure to lock the lock lever located on stacker 4.
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11. If you select stacker 4 as the output stacker, unlock the lock lever located on stacker 4.

c
Caution:
Do not install stacker 3.

12. Close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stackers, access EPSON Total Disc Maker by following the instructions 
below to make settings for writing discs (only for the PP-100III) and create labels for the discs.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.

Registering Data (Only for PP-100III)

The following instructions explain how to register data to be written on discs.

1. Start EPSON Total Disc Maker.
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2. Select type of discs to be published from the list, then click Apply.
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3. Drag and drop files or folders to the data tree or data list. For details, see Help for EPSON Total 
Disc Maker.

Note:
❏ Clicking Auto Insert Data... enables you to set for Merge data and burn. For details, see Help for 

EPSON Total Disc Maker.

❏ To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Creating Labels

The following instructions explain how to create labels using templates provided with the 
software.

1. Click Label on the menu bar of EPSON Total Disc Maker.
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2. Click Template tab and select a label design from the list, then click Apply.
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3. Make changes on the label as needed in the Background, Edit Item, and Layout tabs. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Making the Stacker Settings

The following instructions explain how to set stackers.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
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3. Set Stacker Settings.

❏ For the PP-100III

Publish Mode: Select External Output mode.

Stacker 1: Select the type of discs that you loaded into stacker 1.

Stacker 2: Select the type of discs that you loaded into stacker 2.

Stacker 3: If you want to eject published discs to stacker 3, select Output 
Stacker.

If you want to eject published discs to stacker 4, select Do not 
use.

❏ For the PP-100AP

Publish Mode: Select External Output mode.

4. Click OK.
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Publishing Discs

The following instructions explain how to publish discs.

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For details, see 
Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.

2. Click the Publish button.

The published discs are output to stacker 3 or stacker 4 according to your setting.
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c
Caution:
❏ Do not open the disc cover, maintenance box cover, and ink cartridge cover while a job is 

being processed (while the Busy light is flashing). This could adversely affect the writing or 
printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job may be resumed when Windows 
restarts next time.

❏ Only for the PP-100III: 

❏ Depending on the disc or the computer used, writing speed may become slower than 
the set speed.

❏ Depending on the disc used, the recommended writing speed of the disc cannot be 
used. In this case, reduce the writing speed. Especially with DVD±R DL and BD-R DL, it is 
recommended to write with slow speed.
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Low-Volume Mode (For PP-50II)

Loading Discs

Follow the steps below to load discs.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. Take out stacker 2.

7. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.

8. Load discs into stacker 2 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.
Publishing Discs 75



9. Insert stacker 2.

10. Close the disc cover.

c
Caution:
Before closing the disc cover, make sure that there is no disc left near stacker 3 and that discs in 
stacker 3 are not slanted. Otherwise, an error may occur when you close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stackers, access EPSON Total Disc Maker by following the instructions 
below to make settings for writing discs and create labels for the discs.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.
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Registering Data

The following instructions explain how to register data to be written on discs.

1. Start EPSON Total Disc Maker.

2. Select type of discs to be published from the list, then click Apply.
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3. Drag and drop files or folders to the data tree or data list. For details, see Help for EPSON Total 
Disc Maker.

Note:
❏ Clicking Auto Insert Data... enables you to set for Merge data and burn. For details, see Help for 

EPSON Total Disc Maker.

❏ To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Creating Labels

The following instructions explain how to create labels using templates provided with the 
software.

1. Click Label on the menu bar of EPSON Total Disc Maker.
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2. Click Template tab and select a label design from the list, then click Apply.
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3. Make changes on the label as needed in the Background, Edit Item, and Layout tabs. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Making the Stacker Settings

The following instructions explain how to set stackers.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
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3. Set Stacker Settings.

❏ Publish Mode: Select Low-volume mode.

❏ Stacker 1: Select the type of discs that you loaded into stacker 1.

❏ Stacker 2: Select the type of discs that you loaded into stacker 2.

4. Click OK.
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Publishing Discs

The following instructions explain how to publish discs.

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For details, see 
Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.

2. Click the Publish button.

The published discs are output to stacker 3.
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c
Caution:
❏ Do not open the disc cover and ink cartridge cover while a job is being processed (while the 

Busy light is flashing). This could adversely affect the writing or printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job may be resumed when Windows 
restarts next time.

❏ Depending on the disc or the computer used, writing speed may become slower than the set 
speed.

❏ Depending on the disc used, the recommended writing speed of the disc cannot be used. In 
this case, reduce the writing speed. Especially with DVD±R DL and BD-R DL, it is 
recommended to write with slow speed.
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Batch Mode (For PP-100III/PP-100AP)

Loading Discs

Follow the steps below to load discs.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. Take out stacker 2.

7. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.

8. Load discs into stacker 2 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.
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9. Insert stacker 2.

10. Insert stacker 3.

c
Caution:
❏ Make sure that there are no discs in stackers 3 and 4.

❏ Do not pull out stacker 4. Be sure to lock the lock lever located on stacker 4.
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11. Close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stackers, access EPSON Total Disc Maker by following the instructions 
below to make settings for writing discs (only for the PP-100III) and create labels for the discs.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.
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Registering Data (Only for PP-100III)

The following instructions explain how to register data to be written on discs.

1. Start EPSON Total Disc Maker.

2. Select type of discs to be published from the list, then click Apply.
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3. Drag and drop files or folders to the data tree or data list. For details, see Help for EPSON Total 
Disc Maker.

Note:
❏ Clicking Auto Insert Data... enables you to set for Merge data and burn. For details, see Help for 

EPSON Total Disc Maker.

❏ To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Creating Labels

The following instructions explain how to create labels using templates provided with the 
software.

1. Click Label on the menu bar of EPSON Total Disc Maker.
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2. Click Template tab and select a label design from the list, then click Apply.
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3. Make changes on the label as needed in the Background, Edit Item, and Layout tabs. For 
details, see Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Making the Stacker Settings

The following instructions explain how to set stackers.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
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3. Set Stacker Settings.

❏ For the PP-100III

Publish Mode: Select Batch mode.

Stacker 1: Select the type of discs that you loaded into stackers 1 and 2.

❏ For the PP-100AP

Publish Mode: Select Batch mode.

4. Click OK.
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Publishing Discs

1. Make the publish settings on the Publish screen of EPSON Total Disc Maker. For details, see 
Help for EPSON Total Disc Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.

2. Click the Publish button.

The published discs are output to stacker 2 and stacker 3.
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c
Caution:
❏ Do not open the disc cover, maintenance box cover, and ink cartridge cover while a job is 

being processed (while the Busy light is flashing). This could adversely affect the writing or 
printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job may be resumed when Windows 
restarts next time.

❏ Only for the PP-100III: 

❏ Depending on the disc or the computer used, writing speed may become slower than 
the set speed.

❏ Depending on the disc used, the recommended writing speed of the disc cannot be 
used. In this case, reduce the writing speed. Especially with DVD±R DL and BD-R DL, it is 
recommended to write with slow speed.
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Read Back Mode (For PP-100III)

Loading Discs

Follow the steps below to load discs to be read.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs to be read into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. If you want to eject error discs to stacker 3, insert stacker 3.

c
Caution:
❏ Make sure that there are no discs in stackers 3 and 4.

❏ Do not pull out stacker 4. Be sure to lock the lock lever located on stacker 4.

7. If you want to eject error discs to stacker 4, unlock the lock lever located on stacker 4.
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8. Close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stacker, access EPSON Total Disc Maker by following the instructions 
below to make settings for reading back data from discs and storing the data.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.

Setting Read Back

The following instructions explain how to set read back operation.

1. Start EPSON Total Disc Maker.
Publishing Discs 103



2. Select Read Back from the list, then click Apply.
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3. Make the read back settings, then click Apply. For details, see Help for EPSON Total Disc 
Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Making the Stacker Settings

The following instructions explain how to set stackers.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
Publishing Discs 106



3. Set Stacker Settings.

❏ Publish Mode: Select Read Back mode.

❏ Stacker 3: If you want to eject error discs to stacker 3, select Error Disc 
Output Stacker.
If you want to eject error discs to stacker 4, select Do not use.

4. Click OK.
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Publishing Discs

The following instructions explain how to publish.

1. Set the number of discs to be read for Copies on the Publish screen of EPSON Total Disc 
Maker.

2. Click the Publish button.

The published discs are output to stacker 2.
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c
Caution:
❏ Do not open the disc cover, maintenance box cover, and ink cartridge cover while a job is 

being processed (while the Busy light is flashing). This could adversely affect the writing or 
printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job will be resumed when Windows 
restarts next time. However, the disc in the drive will be ejected as an error disc.
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Read Back Mode (For PP-50II)

Loading Discs

Follow the steps below to load discs to be read.

1. Open the disc cover.

2. Take out stacker 1.

3. Fan a stack of discs to prevent them from sticking together. Be careful not to scratch the 
recording side of the discs.
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4. Load discs to be read into stacker 1 with the printable side facing up.

c
Caution:
❏ Do not load the discs above the dotted red line marked on the stacker; otherwise, the 

discs or product may be damaged.

❏ Do not mix CDs/DVDs with BDs in the same stacker. Otherwise, a disc pick error can 
easily occur.

5. Insert stacker 1.
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6. Close the disc cover.

c
Caution:
Before closing the disc cover, make sure that there is no disc left near stacker 3 and that discs in 
stacker 3 are not slanted. Otherwise, an error may occur when you close the disc cover.

Accessing EPSON Total Disc Maker

After loading discs into the stacker, access EPSON Total Disc Maker by following the instructions 
below to make settings for reading back data from discs and storing the data.

Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click EPSON 
Total Disc Maker.

To learn how to use EPSON Total Disc Maker, go to the Help menu.

Setting Read Back

The following instructions explain how to set read back operation.

1. Start EPSON Total Disc Maker.
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2. Select Read Back from the list, then click Apply.
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3. Make the read back settings, then click Apply. For details, see Help for EPSON Total Disc 
Maker.

Note:
To access Help for EPSON Total Disc Maker, select Help from the Help menu.
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Setting the Publish Mode

The following instructions explain how to set publish mode.

1. Click Publish on the menu bar of EPSON Total Disc Maker.

2. Click Properties on the Publish screen of EPSON Total Disc Maker or EPSON Total Disc Setup.
Publishing Discs 115



3. Select Read Back mode for Publish Mode.

4. Click OK.
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Publishing Discs

The following instructions explain how to publish.

1. Set the number of discs to be read for Copies on the Publish screen of EPSON Total Disc 
Maker.

2. Click the Publish button.

The published discs are output to stacker 2.
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c
Caution:
❏ Do not open the disc cover and ink cartridge cover while a job is being processed (while the 

Busy light is flashing). This could adversely affect the writing or printing quality.

❏ If a job is being processed (while the Busy light is flashing) and you need to open the disc 
cover to load or take out discs, first pause the job and then open the disc cover. See “Pausing 
Publishing” on page 121 for the procedure to pause a job.

❏ If you open the disc cover while a job is being processed (while the Busy light is flashing), an 
alarm beep sounds and the current job enters the standby status. Closing the disc cover 
automatically resumes the job.

❏ While an alarm beep is sounding, the arm is moving. To ensure safety, do not put your 
hands inside the product. Also, do not operate any stackers while an alarm beep is 
sounding. This could damage the arm.

❏ If Windows shuts down while processing a job, the job will be resumed when Windows 
restarts next time. However, the disc in the drive will be ejected as an error disc.
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Taking Out Discs

Follow the steps below to take out the published/read discs from the stackers.

For PP-100III/PP-100AP

c
Caution:
If you select stacker 4 as the output stacker in Standard mode or External Output mode,

❏ Do not yank stacker 4 when pulling it out to remove published discs.

❏ Do not pull out stacker 4 when the stacker 4 LED is flashing fast. Discs may be damaged.

1. Open the disc cover (only for output to stacker 2 or 3), and take out the stacker. 

2. Take out the published/read discs from the output stacker.

Note:
❏ Once the output stacker becomes full, the job is paused. The job is resumed automatically if you 

take out the published discs from the stacker.

❏ Be sure to let printed discs dry completely before using them or touching the printed surface. 
Allow Epson specified discs to dry for at least 1 hour and other types of discs for at least 24 hours.

❏ If the print position is misaligned, adjust it using the printer driver. For details, refer to the printer 
driver Help.

❏ If the ink smears, adjust the color saturation. For details, refer to the printer driver Help.

Stacker 2 Stacker 3 Stacker 4
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❏ When publishing discs using Batch mode, the number of discs output to stacker 3 is not always 
the same as the number of discs loaded into stacker 2. Also, the number of discs does not always 
become 50. The same applies to the number of discs output to stacker 2. For Batch mode, the 
output stacker switches to stacker 2 when the ejected discs accumulated in stacker 3 reach the 
height limit. As a result, the number of discs output to the stacker depends on the thickness of the 
discs used.

For PP-50II

1. Open the disc cover. 

2. Take out the stacker only when the output stacker is stacker 2.

3. Take out the published/read discs from the stacker. The output stacker differs according to 
the publish mode. Refer to the following table.

Note:
❏ Once the output stacker becomes full, the job is paused. The job is resumed automatically if you 

take out the published discs from the stacker.

❏ Be sure to let printed discs dry completely before using them or touching the printed surface. 
Allow Epson specified discs to dry for at least 1 hour and other types of discs for at least 24 hours.

❏ If the print position is misaligned, adjust it using the printer driver. For details, refer to the printer 
driver Help.

❏ If the ink smears, adjust the color saturation. For details, refer to the printer driver Help.

Output stacker Publish mode Number of discs

Stacker 2 Standard mode
Read Back mode

Up to about 50 discs

Stacker 3 Standard mode
Low-volume mode

Up to about 20 discs

Stacker 2 Stacker 3
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Pausing Publishing

If you need to pause publishing, follow the instructions below.

When you start publishing, the screen of EPSON Total Disc Monitor appears on your computer 
screen. Select the job you want to pause in the Unfinished Job list, and then select Pause Job 
from the Job menu or click  button.

Note:
❏ If there is a disc being published, the job is paused after the processing is finished.

❏ The processing of any subsequent job also does not start while the job is paused. 
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Resuming Publishing

If you need to resume publishing, follow the instructions below.

Start EPSON Total Disc Monitor. Select the job you want to resume in the Unfinished Job list, and 
then select Resume Job from the Job menu or click  button.
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Canceling Publishing

If you need to cancel publishing, follow the instructions below.

Start EPSON Total Disc Monitor. Select the job you want to cancel in the Unfinished Job list, and 
then select Cancel Job from the Job menu or click  button.

Note:
If a disc is being published, that processing is stopped, and the disc is output to the output stacker.
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Priority Publishing

If you need to process a job before the others when more than one job is being published, follow 
the instructions below.

Start EPSON Total Disc Monitor. Select the job you want to give priority to in the Unfinished Job 
list, and then select Priority Publishing from the Job menu or click  button. The selected job 
will be processed after the job in progress.

Note:
Any job cannot be given priority before such operations as nozzle checking, aligning print head, and correcting 
printing position.
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Chapter 3 

Replacing Ink Cartridges

Checking the Ink Cartridge Status

Note:
❏ Epson cannot guarantee the quality or reliability of ink not made by Epson.

❏ When an ink cartridge is running low, the status is displayed on the EPSON Total Disc Monitor.

To check the ink cartridge status, do the following:

❏ EPSON Total Disc Monitor appears automatically when you start a job. You can check the ink 
cartridge status from this window.
You can also run EPSON Total Disc Monitor from the Start menu.
& See “Using EPSON Total Disc Monitor” on page 154.

Note:
If any of the ink cartridges installed in the product is broken, incompatible with the product 
model, or improperly installed, EPSON Total Disc Monitor will not display an accurate calculation 
of the ink cartridge status. Be sure to replace or reinstall any such ink cartridge with an ink 
cartridge supported by the product.
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Precautions on Ink Cartridge Replacement

Read all the instructions in this section before replacing the ink cartridges.

❏ Install all six ink cartridges. The product does not operate if even only one ink cartridge is 
missing.

❏ This product uses ink cartridges equipped with an IC chip that monitors the amount of ink 
used by each cartridge. Cartridges are usable even if they are removed and reinserted. 
However, some ink is consumed each time cartridges are inserted, because the product 
automatically checks their reliability.

❏ The valve in the ink supply port is designed to contain any excess ink that may be released. 
However, careful handling is recommended. Do not touch the supply port of the ink 
cartridge or its surrounding area.

❏ Ink is consumed during the following operations: ink charging when an ink cartridge is 
installed, print head cleaning, and automatic cleaning executed periodically.

❏ For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. 
Ink cartridges with low ink status may not be used when reinserted.

❏ Do not refill the ink cartridges. Other products not manufactured by Epson may cause 
damage that is not covered by Epson's warranties, and under certain circumstances, may 
cause erratic product behavior.

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink from or handle 
the cartridges.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the ink 
supply port. If ink gets on your skin, wash the area thoroughly with soap and water. If ink gets 
into your eyes, flush them immediately with water. If discomfort or vision problems continue 
after a thorough flushing, see a doctor immediately.

❏ Epson recommends the use of genuine Epson ink cartridges. The use of non-genuine ink may 
cause damage that is not covered by Epson's warranties, and under certain circumstances, 
may cause erratic product behavior.

❏ Do not open the ink cartridge package until you are ready to install it in the product.

❏ Use ink cartridges within six months after opening the packages.

❏ Leave the old cartridge installed in the product until you have obtained a replacement; 
otherwise, ink remaining in the print head nozzles may dry out.

❏ You cannot continue printing with an ink cartridge after it has reached its replacement time, 
even if the other cartridges still contain ink. Before printing, replace the used cartridge.
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❏ Do not turn off the product or open the ink cartridge cover while loading ink (Power light is 
flashing). Opening of covers may cause the ink to reload, resulting in more of the ink being 
consumed. Also, normal printing may be disturbed.

❏ If the ink cartridge is not recognized even if it is correctly installed, dirt may be attached to 
the green circuit board. Remove the cartridge, wipe the circuit board with a soft cloth, and 
install it again.

❏ Color adjustment of the product is based on the use of genuine Epson ink cartridges. Use of 
non-genuine ink cartridges may result in reduced print quality and the product performance 
may not be optimum.

❏ When the Ink lamp is flashing or lit, the ink cartridge is not correctly installed. Check that it is 
installed correctly.

❏ If installing an ink cartridge does not provide normal printing, press the Cleaning button for 
3 seconds. If it does not resolve the problem, repeat the process for 1 or 2 times.

❏ By turning off the product using the Power button, print head is automatically covered to 
prevent ink from drying. When not in use after installing ink cartridges, make sure to turn off 
using the Power button. Do not unplug the power cord or shut down the breaker while the 
power is on.

❏ When moving or transporting the product after installing ink cartridges, move or transport 
with ink cartridges installed.
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Replacing an Ink Cartridge

Note:
❏ Do not open the ink cartridge package until you are ready to install it in the product.

❏ To confirm the status of each ink cartridge, see the following section:

& See “Using EPSON Total Disc Monitor” on page 154.

This table describes the status of the lights and the actions you need to take.

 : flashing  : on

To replace an ink cartridge, follow the steps below.

c
Caution:
Do not remove the cartridge from the product until you are ready to replace it with another.

Note:
The illustrations show replacement of the light magenta ink cartridge, but the instructions are the 
same for all the cartridges.

1. Make sure that the  Power light is on, but not flashing.

2. Open the ink cartridge cover.

Note:
Wait for 4 seconds or more before removing the ink cartridge. Otherwise, ink may squirt.

Lights Action

Ink is low. Obtain a replacement ink cartridge.

The ink cartridge has reached its replacement time. Replace the used ink cartridge with 
a new one.
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3. Push in the used cartridge so the cartridge pops out slightly. 

4. Carefully pull the used cartridge straight out of the slot. Dispose of it properly.

5. Remove the new ink cartridge from the package.

c
Caution:
❏ Do not touch the green IC chip on the side of the cartridge. This can damage the ink 

cartridge.

❏ Always install an ink cartridge immediately after removing the old cartridge. If the 
cartridge is not installed promptly, the print head may dry out and be unable to print.

❏ Do not refill the ink cartridge. Other products not manufactured by Epson may cause 
damage that is not covered by Epson's warranties, and under certain circumstances, 
may cause erratic product behavior.
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6. Place the new ink cartridge into the slot. Then push the ink cartridge until it clicks into place.

7. When you are finished replacing cartridges, close the ink cartridge cover.
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Chapter 4 

Maintaining Your Product

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to 
identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the nozzle check utility.

Using the Nozzle Check Utility

Follow the steps below to use the nozzle check utility.

1. Make sure that an unprinted disc is installed in stacker 1.

2. Make sure that no lights are indicating errors and that the disc cover is closed.

3. Access the printer driver.

See “Accessing the Printer Driver” on page 22.

4. Click the Utility tab; then click the Nozzle Check button.

5. Follow the on-screen instructions.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no 
print quality problems, such as gaps or missing segments in the test lines, the print head is 
fine.
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If any segment of the printed lines is missing, as shown below, this could mean a clogged ink 
nozzle.

& See “Cleaning the Print Head” on page 133.
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Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to 
solve these problems by cleaning the print head, which ensures that the nozzles are delivering 
ink properly.

You can clean the print head from your computer using the head cleaning utility in the printer 
driver or from the product by using the buttons.

c
Caution:
❏ Do not open the ink cartridge cover while cleaning print head. Print head cleaning stops if 

the ink cartridge cover is opened.

❏ Print head cleaning consumes ink. Excess print head cleaning will result in reduction of ink 
cartridge life.

Note:
❏ Clean the print head only if print quality declines; for example, if the printout is blurry or the color 

is incorrect or missing.

❏ Use the nozzle check utility first to confirm that the print head needs to be cleaned. This saves ink.

❏ When ink is low you may not be able to clean the print head. When ink has reached its 
replacement time, you cannot clean the print head. Replace the appropriate ink cartridge first.

Using the Head Cleaning Utility

Follow the steps below to clean the print head using the head cleaning utility.

<Normal> <Clogged>
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1. Make sure the product is turned on.

2. Make sure no lights indicate errors and the disc cover is closed.

3. Access the printer driver.

See “Accessing the Printer Driver” on page 22.

4. Click the Utility tab; then click the Head Cleaning button.

5. Follow the on-screen instructions.

The  Power light flashes while the product performs the cleaning cycle.

c
Caution:
Never turn off the product while the  Power light is flashing. Doing so may damage the 
product.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the product 

off and wait at least six hours. Then run the nozzle check again and repeat the head cleaning if 
necessary.

❏ If the print quality still has not improved, at least one of your ink cartridges may be old or 
damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 128.

Using the Product Buttons

Follow the steps below to clean the print head using the product buttons.

1. Make sure the PC is turned on.

2. Make sure the product is turned on.

3. Make sure no lights indicate errors and the disc cover is closed.

4. Press and hold down the Cleaning button for three seconds.

The product starts cleaning the print head and the  Power light begins flashing.

c
Caution:
Never turn off the product while the  Power light is flashing. Doing so may damage the 
product.
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5. When the  Power light stops flashing, print a nozzle check pattern to confirm that the 
head is clean.
& See “Checking the Print Head Nozzles” on page 131.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the product 

off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning 
if necessary.

❏ If the print quality still has not improved, at least one of your ink cartridges may be old or 
damaged and may need to be replaced.
& See “Replacing an Ink Cartridge” on page 128.
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Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this 
problem by using the Print Head Alignment utility in your printer driver. 

Note:
Disc thickness may vary, depending on their manufacturer. Using discs with various thicknesses may 
result in misalignment of the print head. Use the Print Head Alignment utility to check and adjust the 
print head alignment. It is recommended to use the same product and type of discs when publishing 
several discs.

Using the Print Head Alignment Utility

Follow the steps below to align the print head using the print head alignment utility.

1. Make sure an unprinted disc is inserted in stacker 1.

2. Make sure no lights indicate errors and the disc cover is closed.

3. Access the printer driver.

See “Accessing the Printer Driver” on page 22.

4. Click the Utility tab, then click the Print Head Alignment button.

5. Follow the on-screen instructions to align the print head.

c
Caution:
❏ When you enter a value in the confirmation screen after the initial adjustment, adjustment 

will be done using the initial value and the entered value added together. To clear the 
adjustment value, select Reset and click Exit.

❏ If the label printing surface is not aligned with center of the disc after aligning the print 
head as described above, print will appear out of alignment compared to printing surface.
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Correcting the Printing Position

If you notice a misalignment of vertical printing position, you may be able to solve this problem 
by using the Correcting the Printing Position utility in your printer driver. 

Using the Correcting the Printing Position Utility

Follow the steps below to adjust the vertical and horizontal printing position using the 
Correcting the printing position utility.

1. Make sure an unprinted disc is inserted in stacker 1.

2. Make sure no lights indicate errors and the disc cover is closed.

3. Access the printer driver.

See “Accessing the Printer Driver” on page 22.

4. Click the Utility tab, then click the Correcting the Printing Position button.

5. Follow the on-screen instructions to adjust the vertical and horizontal printing position.
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Cleaning Your Product

Cleaning the Exterior of the Product

To keep your product operating at its best, clean it by using the following procedure.

c
Caution:
❏ Wipe with the covers closed so that moisture does not enter the inside of the product. If the 

inside becomes wet, there is a risk that the electrical circuits will short out.

❏ Do not use benzine, paint thinner, alcohol, or other volatile chemicals. There is a risk that 
the inside or outside of the product may change properties or shape.

❏ Do not use a stiff brush. There is a risk of scratching the exterior of the product.

1. Make sure the product is turned off and all the lights are off, and then unplug the power cord 
from the electrical outlet.

2. Use a soft, clean cloth to carefully remove any dust or dirt.

If the dirt does not come off, clean it using a soft, clean cloth dampened with a mild 
detergent. Then, wipe the outside of the product dry with a dry, soft cloth.

Cleaning the Interior of the Product 

If dirt or dust collects in the inside of this product or the stackers, or if dirt adheres to it, use a soft 
cloth to wipe off the dirt.

Ink may sometimes stain stackers. Remove the stains by soaking a soft cloth in water or mild 
detergent, wringing it out, and then wiping them off.
Maintaining Your Product 138



Cleaning the Filter (Only for PP-100III/PP-50II)

Clean the filter located on the rear of the product once every six months.

1. Make sure the product is turned off and all the lights are off, and then unplug the power cord 
from the electrical outlet.

2. Loosen and remove the screws from the filter covers to open them.

3. Remove the filters from the filter covers.

4. Use a vacuum-cleaner to clean the dust on the filters.

PP-100III

PP-50II
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5. Place the filters back in position.

6. Tighten the screws to close the filter covers.

c
Caution:
Clean the filter periodically (once in every six months).

PP-100III

PP-50II
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Getting Maintenance Information

You can get helpful information for maintenance and support of the product, such as the 
cumulative number of published discs, the free space of the maintenance box for the 
PP-100III/PP-100AP, and the service life of the drives for the PP-100III/PP-50II.

1. Make sure that the product is connected to the computer via the USB cable and that the 
product is turned on.

2. Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click 
EPSON Total Disc Setup.

3. Select CD/DVD/BD Publisher, and then click Properties.

4. Click the Maintenance Info tab.

Note:
❏ Only for the PP-100III/PP-100AP: When Maintenance Box free space is close to 0%, it is time to 

replace the maintenance box.

❏ Only for the PP-100III/PP-50II: When Service life of Drive1/Drive2 or Service life of Drive is 
close to 100%, it is time to replace the drive.
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Replacing the Maintenance Box (Only for PP-100III/PP-100AP)

The maintenance box absorbs ink wasted during printing and head cleaning. When the 
maintenance box becomes full, the product stops publishing discs.

Note:
❏ You can check the free space of the maintenance box with EPSON Total Disc Setup.

& See “Getting Maintenance Information” on page 141.

❏ When it is almost time to replace the maintenance box, a message notifying you that it is almost 
time to replace it is displayed once per day when you start up EPSON Total Disc Monitor.

❏ When it is time to replace the maintenance box, all the Ink lamps flash rapidly, and a message 
notifying you that it is time to replace it is displayed on EPSON Total Disc Monitor.

See the instruction manual of the maintenance box to replace the maintenance box. Be sure to 
replace also the filter when you replace the maintenance box.

c
Caution:
❏ Epson recommends the use of genuine Epson maintenance boxes. The use of non-genuine 

maintenance boxes may cause damage that is not covered by Epson's warranties, and 
under certain circumstances, may cause erratic product behavior.

❏ Do not use any maintenance box removed from the product and left for a long period.

❏ Do not tilt the used maintenance box. Otherwise ink may leak.

❏ Do not touch the green IC chip on the maintenance box.

❏ Do not touch the ink ejection port of the maintenance box or the inside of the box insertion 
opening of the product.

❏ Be careful not to touch the ink on the maintenance box cover and filter cover.

❏ Do not take out/put in the maintenance box more than necessary. Otherwise some parts of 
the ink pad may drop inside the product.
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Replacing the Drive (Only for PP-100III)

The two drives of the product are replacable with the exclusive optional BD drives.

When the drives have reached the end of their service life, writing or reading errors can easily 
occur. In that case, replace the drive. The drives can be replaced even before the end of their 
service life.

Note:
❏ You can check the service life of drive 1 and drive 2 with EPSON Total Disc Setup.

& See “Getting Maintenance Information” on page 141.

❏ When it is almost time to replace a drive, a message notifying you that it is almost time to replace 
it is displayed once per day when you start up EPSON Total Disc Monitor.

❏ When it is time to replace a drive, a message notifying you that it is time to replace it is displayed 
once per day when you start up EPSON Total Disc Monitor.

See the instruction manual of the exclusive optional drive to replace drives. 

w
Warning:
Do not put your fingers inside the drive slots.

c
Caution:
❏ Be sure to follow the instructions shown in the instruction manual of the drive when 

replacing the drive.

❏ Both drive 1 and drive 2 must be installed. Otherwise the PP-100III will not operate.

❏ Do not use other drives than the Epson exclusive optional drive. Otherwise the product and 
the drive may be damaged.
& See “Consumables and Options” on page 182.

❏ Do not replace the drives more than 40 times for each slot. Damage of the drive connectors 
can destroy the drive and product.
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Transporting Your Product

If you need to transport your product some distance, carefully prepare and repack it. Be sure to 
use the original box and packing materials.

w
Warning:
The product is heavy, so have two people lift the product.

c
Caution:
❏ When storing or transporting the product, do not tilt it, stand it up vertically, or turn it 

upside down. If you need to transport the product, carefully prepare and repack it using the 
original box and packing materials in order to protect the product from shock.

❏ Leave the ink cartridges installed. Removing the cartridges can dry out the print head and 
may prevent the product from printing.

❏ Only for the PP-100III/PP-100AP: Leave the maintenance box installed. Removing the 
maintenance box may cause ink leakage.

❏ Only for the PP-100III: Be sure to remove the two drives before transporting. Otherwise, the 
drives and the PP-100III may be deformed or damaged. See the instruction manual of the 
exclusive optional drive to remove drives.

1. Turn off the product and unplug its power cord.

2. Disconnect the interface cable.

3. Remove all discs from the stackers.

4. For the PP-100III, remove the two drives.

5. Open the ink cartridge cover. Secure the ink cartridges with tape; then close the ink cartridge 
cover.

6. Close the stacker 4 tray (only for PP-100III/PP-100AP) and the disc cover. Secure them with 
tape.

7. Attach the protective materials to both sides of the product.

8. Repack the product and accessories in the original box.

Note:
❏ Keep the product level during transport.

❏ Be sure to remove the protective materials and tape from the product before using it again.
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❏ Be sure to lift the product by the correct positions, as shown below.
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Chapter 5 

Troubleshooting

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, 
then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by 
Help, the control panel, and the EPSON Total Disc Monitor Utility. Refer to the appropriate 
section below.

If you have a specific problem relating to publishing quality, a problem not related to publishing 
quality, a disc feeding problem, or if the product does not publish at all, refer to the appropriate 
section.

To solve a problem, you may need to cancel publishing.
& See “Canceling Publishing” on page 123.

Error Indicators

You can identify many common problems using the lights on your product. If the product stops 
working and the lights are on or flashing, use the following table to diagnose the problem; then 
follow the recommended corrective measures.

Note:
Condition of indicator lights after error may change, depending on the operation.

The light statuses are indicated as follows. The PP-50II does not have the Stacker 4 light.

on flashing offflashing fast
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Error associated with cover

Error associated with disc transfer

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

Disc cover or ink cartridge cover open
Close covers.

Job is paused because disc cover or ink
cartridge cover was opened while pro-
cessing the job
Wait for the job to resume.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

Disc pick up error
Resolve the problem as follows.
1. Open the disc cover and fan the discs 

inside the input stacker.

2. Close the disc cover and publish disc 
again.

If the same error occurs frequently, contact
your dealer.

Multiple feed error
Resolve the problem as follows.
1. Open the disc cover.

2. Remove the discs from both the drive tray 
and the printer tray.

3. Fan the discs inside the input stacker to 
avoid disc sticking.

4. Insert other discs into the input stacker.

5. Close the disc cover and publish disc 
again.

If the same error occurs frequently, contact
your dealer.
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Error associated with stacker

Disc transfer error
Turn off the product and remove the disc. If 
the same error occurs frequently, contact 
your dealer.

Arm failed to release disc
Turn off the product and remove disc.
Do not remove disc from the arm by hand if 
arm is picking up the disc. This may damage 
the arm. To remove the disc from the arm, 
turn on the product again and let initializing 
process remove the disc.
If the same error occurs frequently, contact 
your dealer.

Internal error
Turn off the product and check inside for any 
objects, then turn on the product again.
If the same error occurs frequently, contact 
your dealer.
Do not remove disc from the arm by hand if 
arm is picking up the disc. This may damage 
the arm. To remove the disc from the arm, 
turn on the product again and let initializing 
process remove the disc.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

Stacker 3 is inserted when stacker 3 is set 
to Do not use in Standard mode, External 
Output mode, or Read Back mode.
Remove stacker 3.

Stacker 1 is not correctly inserted
Make sure stacker 1 is correctly inserted.

Stacker 2 is not correctly inserted
Make sure stacker 2 is correctly inserted.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4
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Stacker 3 is not correctly inserted in Batch 
mode or when stacker 3 is set to:
❏ Use in Standard mode
❏ Output Stacker in External Output mode
❏ Error Disc Output Stacker in Read Back 

mode
Make sure stacker 3 is correctly inserted.

Stacker 1 is empty
Load discs into stacker 1.

Note:
The stacker lamp flashes when the 
source stacker is out of discs; however, 
the timing of the light flashing may 
not match the timing of the stacker 
becoming empty.

Stacker 2 is empty
Load discs into stacker 2.

Note:
The stacker lamp flashes when the 
source stacker is out of discs; however, 
the timing of the light flashing may 
not match the timing of the stacker 
becoming empty.

Stacker 1 is overloaded
Remove discs so that discs are below the 
dotted red line.

Stacker 2 is overloaded
Remove discs so that discs are below the 
dotted red line.

Stacker 3 is overloaded
Remove all the discs from stacker 3.

Stacker 2 is full
Remove published discs from stacker 2.

Stacker 3 is full
Remove published discs from stacker 3.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4
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Error associated with ink

Stacker 4 is full
Remove published discs from stacker 4.

Stacker 4 is open
Close stacker 4.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

Ink low
Obtain a replacement ink cartridge. To 
determine which cartridge is low, check the 
ink cartridge status.
See “Checking the Ink Cartridge Status” on 
page 125.

The ink has reached its replacement time 
or it is not installed correctly.
Replace the ink cartridge or reinstall it. 
If the ink cartridge is not recognized even if it 
is installed correctly, there may be dirt on the 
green circuit board. Wipe it with soft cloth 
and install it again. 
The product will stop operation before ink is 
completely empty in order to maintain print 
head quality. Therefore, some ink will be left 
in the ink cartridge. 
It is recommended to use a genuine ink 
cartridge.

Ink cartridge not fully inserted
All Ink lights are on.
Check ink cartridges and make sure they are 
all fully inserted.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4
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Error associated with printer

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

The maintenance box has reached its 
replacement time or it is not installed 
correctly.
Replace the maintenance box or reinstall it.
If the maintenance box is not recognized 
even if it is installed correctly, there may be 
dirt on the green circuit board. Wipe it with 
soft cloth and install it again.

Printer maintenance error
A printer maintenance error has occurred.
Turn off the product and contact your dealer.

For PP-50II: Ink pad full
Please have an authorized Epson service 
center service the ink pad right away. The 
pad is full and the unit can no longer 
function. Do not attempt to service the unit 
yourself.

Internal error
Turn off the product and check inside for any 
objects. If the same error occurs frequently, 
contact your dealer.
❏ Leaving the product off after the error 

may result in clogging of print head. 
Make sure to turn on the product 
immediately after it is turned off.

❏ If resuming label printing after the error, 
run a nozzle check and confirm the 
condition of the print head.

❏ If publishing does not start, check if a 
print job remains in the print spooler and 
delete all print jobs.
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Error associated with drive (only for PP-100III/PP-50II)

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

Drive tray open/close error
Turn off the product, unplug the power cord, 
and check inside for any objects. Then, 
publish the disc again. If the same error 
occurs frequently, contact your dealer.

Internal drive error
Turn off the product, unplug the power 
cable, and then check the inside of the drive. 
If the same error occurs frequently, contact 
your dealer.

Writing/reading error
The error could not be cleared even if it 
repeated itself for the retry number of times. 
Disc may have a problem. Replace the disc 
and resume job.
If there is a problem with the drive, change 
the drive with EPSON Total Disc Setup and 
resume the job. For the PP-100III, also check 
if the drive has reached the end of its service 
life. If so, replace the drive. See “Getting 
Maintenance Information” on page 141 and 
“Replacing the Drive (Only for PP-100III)” on 
page 143.
If the same error occurs frequently, contact 
your dealer.

Invalid disc error
An invalid disc error has occurred, such as 
the disc may not be blank or the disc does 
not have enough space. Or, the disc loaded 
in the stacker differs from the disc type you 
set in the EPSON Total Disc Setup Properties 
dialog box.
The error could not be cleared even if it 
repeated itself for the retry number of times.
Check that the disc is blank and not 
damaged.
Then, in the EPSON Total Disc Setup 
Properties dialog box, select the disc type 
that is the same as the discs loaded in the 
stacker. If you use the proper disc but the 
same error occurs frequently, contact your 
dealer.
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Other error

EPSON Total Disc Monitor

If a problem occurs while publishing, an error message will appear in the EPSON Total Disc 
Monitor window.

If an error message appears indicating the parts inside the product are near the end of their 
service life or the waste ink pad in the product is saturated, contact your dealer to replace it.

Lights

Conditions/Remedies
Power Busy Error Ink

Stacker

1 2 3 4

Improper status error
Turn the product off and on. If the same error 
occurs frequently, contact your dealer.
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Checking Product Status

Using EPSON Total Disc Monitor

EPSON Total Disc Monitor displays detailed information on the product status.

There are three ways to access EPSON Total Disc Monitor:

❏ When you send a job to the product, EPSON Total Disc Monitor appears.

❏ In the EPSON Total Disc Maker window, click the Publish button. From the Tool menu, select 
Start Total Disc Monitor.

❏ Click Start ( ), point to All Programs, click EPSON Total Disc Maker, and then click 
EPSON Total Disc Monitor.

When you access EPSON Total Disc Monitor, the following window appears:

EPSON Total Disc Monitor provides the following information:

❏ Job List:
You can check a list of jobs (up to 1000 for Unfinished Job and 50 for Finished Job) and its 
information, and also you can cancel, pause, and restart unfinished jobs.

Operation
Guidance

Ink Cartridge 
Status Drive/Printer/

Stacker Status

Job List

Interface
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❏ Interface (only for the PP-100III):
USB 3.0 appears when the product is connected via USB 3.0 interface. USB 2.0 appears when 
the product is connected via USB 2.0 interface.

❏ Operation Guidance:
This provides device status information. It also displays error messages as well as helpful tips 
for better publishing. 

❏ Ink Cartridge Status:
This provides a graphic display of the ink cartridge status.

Note:
Printable copies is an approximate value based on the number of labels that can be printed from 
the present time when printing the same label as last time. This value may differ from the actual 
value as a result of influences such as the printing data and printing environment. Up to 1000 is 
indicated as “1000 or more discs,” and less than 1000 is indicated in increments of 10.

❏ Drive (only for the PP-100III/PP-50II), Printer, Stacker Status:
This provides a graphic display of the drives, printer, and stacker status. It also shows where 
an error occurs.
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Disc or the Disc Tray Does Not Feed Correctly

Disc Does Not Feed

Remove the stack of discs and make sure of the following:

❏ The disc is not damaged.

❏ The disc is not too old. See the instructions that came with the disc for more information.

❏ The discs are not loaded above the dotted red line in the stacker.

❏ Discs may have stuck together because of incorrect transportation of the discs; therefore, 
discs should be separated thoroughly before loading into the stacker. Also, storing discs in 
the stacker for an extended period of time may cause discs to stick to each other again. If 
discs are stored in the stacker for an extended period of time, separate the discs again before 
operating the product.

❏ A disc is not jammed inside the product. If it is, remove the jammed disc.
& See “Disc Jams” on page 157.

❏ The ink cartridges have not reached replacement time. If a cartridge has reached its 
replacement time, replace it.
& See “Replacing an Ink Cartridge” on page 128.

If a disc does not feed from the input stacker:

1. Open the disc cover.
2. Remove discs from the stacker.
3. Fan a stack of discs to prevent them from sticking together. 
4. Insert discs back in the stacker.
5. Close the disc cover.
6. Publish disc again.

If a disc does not feed from the drive tray or the printer tray:

1. Turn the power off.
2. Turn the power back on.
3. Publish disc again.

If the arm has picked up a disc:

Do not remove the disc by hand, as the arm may be damaged. To remove the disc, turn off the 
power and turn on the power again, and let the initializing process remove the disc.

If the same error continues to occur, contact your dealer.
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Multiple Disc Feeds

❏ Make sure the disc stack fits under the dotted red line in the stacker.

❏ Make sure none of the discs are damaged.

❏ Remove the stack of discs and make sure the discs are not too thin.
& See “Discs” on page 183.

❏ Remove discs from the stacker and fan them before loading them back.

❏ If only one disc is found when multiple feed error is displayed, disc thickness or warpage 
maybe out of standard. Follow the steps below to resolve the multiple disc feed error and 
replace discs. If the same error continues to occur, contact your dealer.

1. Open the disc cover.
2. Remove the disc from the tray.
3. Remove discs from the input stacker.
4. Insert other discs into the input stacker.
5. Close the disc cover and the job will resume.

Disc Jams

If a disc is left in the drive or printer tray, it will be ejected when you turn off/on the product. 
If you cannot remove the disc by restarting the product, follow the procedures below:

If a disc is stuck in the printer tray

❏ For the PP-100III

1. Turn off the product and unplug the power cable from the wall outlet.
2. Remove 2 screws to open the maintenance box cover.
3. Push the printer tray.

4. Open the disc cover, remove all the discs inside, and then close the disc cover.
5. Close the maintenance box cover.
Troubleshooting 157



6. Plug the power cable into the wall outlet and turn on the product. 
The printer tray automatically closes.

❏ For the PP-50II

1. Turn off the product and unplug the power cable from the wall outlet.
2. Remove 2 screws to open the rear printer cover.
3. Push the printer tray.

4. Open the disc cover, remove all the discs inside, and then close the disc cover.
5. Close the rear printer cover.
6. Plug the power cable into the wall outlet and turn on the product. 

The printer tray automatically closes.

❏ For the PP-100AP

1. Turn off the product and unplug the power cable from the wall outlet.
2. Remove 2 screws to open the maintenance box cover.
3. Pull out the maintenance box.

c
Caution:
❏ Do not tilt the used maintenance box. Otherwise ink may leak.

❏ Do not touch the ink ejection port of the maintenance box or the inside of the box insertion 
opening of the product.
Troubleshooting 158



4. Push the printer tray.

5. Open the disc cover, remove all the discs inside, and then close the disc cover.
6. Reinstall the maintenance box and close the maintenance box cover.
7. Plug the power cable into the wall outlet and turn on the product. 

The printer tray automatically closes.

If a disc is stuck in the drive tray (only for PP-100III/PP-50II)

1. Turn off the product and unplug the power cable from the wall outlet.
2. Open the disc cover.
3. Insert a pin into the eject hole to open the tray forcibly.
4. Remove all the discs inside.
5. Push the tray to close it.

Note:
Insert a pin into the hole and push to eject the tray when the tray doesn’t unload by pressing the 
Eject button. In normal operation, the eject button should be used to unload the tray. Make sure 
the power of the product is turned off and wait more than one minute until disc rotation is 
stopped before accessing with the eject hole.

Note:
❏ If you cannot easily remove a foreign object, do not use force and do not disassemble the product. 

Call your dealer for assistance.

❏ If the arm is stopped while picking up disc, do not try removing disc by hand. This may result in 
damaging the arm. If such an error occurs, turn off/on the power and try resolving the problem by 
initializing the product. If the error continues to occur, contact customer support.

If your discs jam frequently, make sure of the following:

❏ The discs are smooth, not damaged.

❏ You are using high-quality discs.

❏ The printable sides of the discs are face up in the stacker.

❏ The stack of discs was fanned before loading.
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❏ The stack of discs is not loaded above the dotted red line in the stacker.

❏ The number of discs in the stacker does not exceed the limit specified for that disc.
& See “Mechanical” on page 190.

❏ The product is on a flat, stable surface that extends beyond the base in all directions. The 
product will not operate properly if it is tilted.

Writing/Reading Problem (Only for PP-100III/PP-50II)

Cannot Write to/Read from the Disc

Avoid using the product where dust or smoke is abundant. It may result in write/read error. 
If a disc write/read error occurs frequently, check the following:

❏ The disc is not damaged.

❏ The disc is high-quality.

❏ The disc session has been closed.

❏ The product is used within acceptable environmental conditions.

❏ The product is not subject to vibration or shock.

❏ The fan filter is not clogged with dust.

❏ The printer tray is not dirty.

❏ The drive has not reached the end of its service life.
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Print Quality Problems

If you are having a print quality problem, then compare it with the illustrations below. Click the 
caption under the illustration that best resembles your printout.

Good sample Good sample

“Horizontal Banding” on page 162 “Vertical Misalignment” on page 162

“Horizontal Banding” on page 162 “Vertical Misalignment” on page 162

“Incorrect or Missing Colors” on page 163 “Blurry or Smeared Printout” on page 163
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Horizontal Banding

❏ Make sure the printable side of the disc is face up in the stacker.

❏ Run the head cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 133.

❏ Use ink cartridges within six months after opening the packages.

❏ Use genuine Epson ink cartridges.

❏ Check the H Ink light. If the light is on, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 128.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 25.

Vertical Misalignment

❏ Run the print head alignment utility.
& See “Aligning the Print Head” on page 136.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 25.

Banding

❏ Make sure the printable side of the disc is face up in the stacker.

❏ Run the head cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 133.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 25.

❏ Due to the variation in the quality of discs, print results using the same type of discs from the 
same data may not be the same.
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Incorrect or Missing Colors

❏ Adjust the color settings in your application or in your printer driver settings.
Check the Main window. 
See the printer driver online Help for details.

❏ Run the head cleaning utility.
& See “Cleaning the Print Head” on page 133.

❏ Check the H Ink light. If the light is on, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 128.

❏ If you have just replaced an ink cartridge, make sure the date on the ink cartridge or the box 
has not expired. If you have not used the product for a long time, replace the ink cartridges.
& See “Replacing an Ink Cartridge” on page 128.

Blurry or Smeared Printout

❏ Use genuine Epson ink cartridges.

❏ Make sure the product is on a flat, stable surface that extends beyond the base in all 
directions. The product will not operate properly if it is tilted.

❏ Make sure your disc is not damaged, dirty, or too old.

❏ Make sure your disc is dry and the printable side is facing up.

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 25.

❏ Do not touch or allow anything to come into contact with the printed side of a disc with a 
shiny finish. After printing on a glossy disc, allow the ink to set for a few hours before 
handling it.

❏ Run the head cleaning utility.
& See “Cleaning the Print Head” on page 133.
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Miscellaneous Printout Problems

Incorrect or Garbled Characters

❏ Clear any stalled print jobs from the Windows Spooler.

❏ Turn off the product and computer. Make sure the product’s interface cable is securely 
plugged in.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling Software” on page 24.

Incorrect Margins

❏ Check the Inner/Outer Diameter settings in your application. Make sure the margins are 
within the printable area of the disc.
& See “Printable area” on page 185.

❏ Make sure the printer driver settings are appropriate for the label size you are using.
Check the Main window.
See the printer driver online Help for details.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling Software” on page 24.

❏ The printing location may shift depending on the disc used. Perform print head alignment or 
correcting the printing position.
& See “Correcting the Printing Position” on page 137.

❏ The ink receptor layer may shift from the center of the disc, making the print location appear 
shifted from the ink receptor layer. Check if the ink receptor layer is shifted from the center of 
the disc or from the outer edge.

Printout Has a Slight Slant

❏ Run nozzle check, print head cleaning, and print head alignment utilities.

Printed Side is Smeared or Scuffed

❏ Select the appropriate disc size setting in the printer driver.
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❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling Software” on page 24.

Printing is too Slow

❏ Make sure the label type selected in the printer driver is appropriate for the type of disc 
loaded in the product.
& See “Publishing Discs” on page 25.

❏ Close any unnecessary applications.

❏ Make sure the checkbox for High Speed is checked in the printer driver.

❏ If you print continuously for an extended period, the discs may temporarily stop feeding or 
the printing may pause for a while. This is to slow down the printing speed and prevent the 
product mechanism from overheating and being damaged. If this happens, you can 
continue to print, but we recommend stopping and leaving the product for about thirty 
minutes with the power on. (The product will recover after about 3 hours with the power off.) 
After you restart, the product will print at normal speed.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling Software” on page 24.

Ink Adheres to the Recording Surface

❏ Depending on the type of disc, ink may adhere to the recording surfaces if they are stacked 
right after printing. Make sure of the type of disc before using.

❏ Keep the printed surface of the disc away from other discs until ink on the printed disc is 
completely dry, otherwise marks or smudges may be left at the area where discs come into 
contact.
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The Product Does Not Function

All Lights Are Off

❏ Press the P Power button to make sure the product is on.

❏ Turn off the product, and make sure the power cord is securely plugged in.

❏ Make sure your outlet works and is not controlled by a wall switch or timer.

Lights Came On and then Went Out

The product’s voltage may not match the outlet rating. Turn off the product and unplug it 
immediately. Then check the label on the back of the product.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRODUCT BACK IN. Contact your dealer.

Only the Power Light is On

❏ If you press the P Power button lightly, the product may not turn on, although the  
Power light flashes for a while. Press the button firmly.

❏ Turn off the product and computer. Make sure the product’s interface cable is securely 
plugged in.

❏ If you are trying to print a large image, your computer may not have enough memory. Try 
reducing the resolution of your image or printing the image at a smaller size. You may need 
to install more memory in your computer.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling Software” on page 24.

The Ink Light is Flashing or is On after you Replace the Cartridge

Make sure the ink cartridge is correctly installed.
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Software Cannot be Installed

❏ Is the USB cable unplugged? Make sure the USB cable is firmly connected.

❏ Does the USB cable match the specifications for the computer and the product? The USB 
cable used to connect the computer and the product should be 2.0 compatible. You can also 
use USB 3.0 cables for the PP-100III.

❏ Does the HDD have sufficient free space? The software cannot be installed if the HDD does 
not have sufficient free space.
& See “System Requirements” on page 14.

❏ Did you log on as a user with administrator privileges (belonging to the administrator group) 
for Windows? When installing the software, log on as a user with administrator privileges 
(belonging to the administrator group).

❏ Are you using a USB hub? The USB cable should be connected directly between the PC and 
the product.

❏ Is Windows Media Player installed? Windows Media Player must be installed before installing 
the Total Disc Maker.

❏ The output device may not be recognized in an environment with Windows Media Player 7 
installed. In this case, uninstall EPSON Total Disc Maker and restart the computer, then 
reinstall EPSON Total Disc Maker.

❏ If the language setting of the system is different from the user, installation may not be 
correctly performed. Make sure to set the language setting of the system and the user the 
same before installation.

When installing the software, make sure to turn the product off; then start installation. 

Disc Cannot be Published

If the user is logged on as a guest and could not access the service; terminal service must be 
enabled before publishing (except for Windows 10, Windows 8.1, Windows 8, or Windows 7). 
Contact administrator for terminal service settings.

Disc Information Cannot be Read (Only for PP-100III/PP-50II)

If "The disc information cannot be read. You must be logged on with administrator privileges." 
message is displayed, log onto Windows with administrator privileges.
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The Product is not Recognized (Only for PP-100III)

If the product is not recognized with EPSON Total Disc Setup after if even either one of the drives 
is replaced, the drive may not be inserted correctly. Turn off the product, disconnect the power 
cable from the wall outlet, and then firmly push the replaced drive completely inside.

Maintenance Box Nearly Full Message is Displayed by the Software 
(Only for PP-100III/PP-100AP)

The maintenance box is nearly full. 
& See “Replacing the Maintenance Box (Only for PP-100III/PP-100AP)” on page 142.

Ink Pad Nearly Full Message is Displayed by the Software (Only for 
PP-50II)

Ink pad is nearly full. Please have an authorized Epson service center replace the ink pad right 
away. The pad is nearly full, and the unit will stop functioning when the pad becomes full. Do not 
attempt to service the unit yourself.
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Appendix A 

Where To Get Help

Contacting Customer Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the 
troubleshooting information in your product documentation, contact customer support 
services for assistance. If customer support for your area is not listed below, contact the dealer 
where you purchased your product.

Customer support will be able to help you much more quickly if you give them the following 
information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product
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Help for Users in the United States and Canada

Contacts for information, support, and services are:

Discproducer Technical Support: 562-276-1360

Location: Epson America Inc.

Web site URL: www.epson.com/support/

This site will provide the end user with access to the latest drivers and FAQs.

Help for Users in the Europe (EMEA)

Contacts for information, support, and services are:

Web site URL: www.epson-europe.com

Or contact your local distributor or Epson sales company.

If you need the latest drivers, FAQs, manuals, or other downloadable, access the site at:

www.epson-biz.com/

Help for Users in Australia

Contacts for information, support, and services are:

Epson Australia Pty Ltd

3 Talavera Road

North Ryde NSW 2113

Australia

Phone: 02-8899-3666

Fax: 02-8899-3777

If you need the latest drivers, FAQs, manuals, or other downloadable, access the site at:

www.epson.com.au
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Help for Users in Southeast Asia

Contacts for information, support, and services are:

PT Epson Indonesia

CIBIS Tower 9, 3rd floor

Cibis Business Park

Jalan T.B.Simatupang No. 2

Jakarta 12560

Tel: 021 572 3161

Fax: 021 572 4357

Helpdesk: 0807 11 37766

www.epson.co.id

Epson Singapore Pte Ltd

1 HarbourFront Place

#03-02 HarbourFront Tower 1

Singapore 098633

Helpdesk: 6586 3111

www.epson.com.sg

Epson Malaysia Sdn Bhd

3rd Floor, East Tower,

Wisma Consplant 1,

No.2 Jalan SS 16/4,

47500 Subang Jaya, Selangor DE,

Malaysia

Tel: 03-5628 8288
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Fax: 03-5621 2088

Helpdesk: 03-5521 5888

www.epson.com.my

Epson (Thailand) CO., Ltd.

195 Empire Tower 42nd Floor,

South Sathorn Road Yannawa

Sathorn, Bangkok 10120

Thailand,

Tel: 0-2685-9888

Fax: 0-2685-9889

Helpdesk: 0-2685-9899

www.epson.co.th

Epson Philippines Corporation

8th Floor, Anson's Centre

#23 ADB Avenue,

Pasig City 1605, Philippines

Trunkline: 63-2 706-2609

Customer Care:

Trunkline: 63-2 706-2609 (Press 2)

Fax: 63-2 706-2663

Toll-Free No.: 1-800-1068-EPSON (37766)

www.epson.com.ph
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Appendix B 

Product Information

Product Parts and Control Panel Functions

Front Parts

a. Ink cartridge cover: Secures the ink cartridges. Open only when installing or replacing ink 
cartridges.

b. Control panel: Use the button and monitor the lights to control your product. See the next 
section for details.

c. Disc cover: Open when loading or taking out the discs.

d. Power button: Turns the product on or off.
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Rear Parts

PP-100III

e. AC inlet: Plug in the power cord.

f. USB connector: Connects a USB cable from your computer to the product. 

g. Interface cable locking saddle: Use this for directing and gathering the cable.

h. Air vent: Leave at least 10 cm (3.94") between the back of the product and the wall for ventilation.

i. Maintenance box cover: Open this cover when replacing a maintenance box or removing a disc 
stuck in the printer tray.
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PP-50II

c
Caution:
Before opening the rear printer cover, be sure to unplug the power cable from the wall outlet. Be 
sure to attach this cover while in use.

e. AC inlet: Plug in the power cord.

f. USB connector: Connects a USB cable from your computer to the product. 

g. Interface cable locking saddle: Use this for directing and gathering the cable.

h. Air vent: Leave at least 10 cm (3.94") between the back of the product and the wall for ventilation.

i. Rear printer cover: Open this cover only when a disc is stuck in the printer tray.
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PP-100AP

e. AC inlet: Plug in the power cord.

f. USB connector: Connects a USB cable from your computer to the product. 

g. Interface cable locking saddle: Use this for directing and gathering the cable.

h. Maintenance box cover: Open this cover when replacing a maintenance box or removing a disc 
stuck in the printer tray.

i. Air vent: Leave at least 10 cm (3.94") between the back of the product and the wall for ventilation.
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Interior parts

PP-100III

j. Drive 1: Writes/reads data on the recording surface of discs.

k. Drive 2: Writes/reads data on the recording surface of discs.

l. Arm: Transports discs.

m. Stacker 1: Use stacker 1 as a disc input stacker. Holds up to 50 discs.

n. Stacker 2: Use stacker 2 as a disc input or output stacker. Holds up to about 50 discs.

o. Lock lever: Use this lever to lock or unlock stacker 4. Lock the lever when you use stacker 3.

p. Stacker 3: Use stacker 3 as a disc output stacker. Holds up to about 50 discs.

q. Stacker 4: Use stacker 4 as a disc output stacker. Holds up to about 5 discs.

r. Printer: Prints on label surface of discs.

s. Drive release lever 2: Use this lever to unlock drive 2.

t. Drive release lever 1: Use this lever to unlock drive 1.
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PP-50II

j. Drive: Writes/reads data on the recording surface of discs.

k. Arm: Transports discs.

l. Stacker 1: Use stacker 1 as a disc input stacker. Holds up to 50 discs.

m. Stacker 2: Use stacker 2 as a disc input or output stacker. Holds up to about 50 discs.

n. Stacker 3: Use stacker 3 as a disc output stacker. Holds up to about 20 discs.

o. Printer: Prints on label surface of discs.
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PP-100AP

j. Arm: Transports discs.

k. Stacker 1: Use stacker 1 as a disc input stacker. Holds up to 50 discs.

l. Stacker 2: Use stacker 2 as a disc input or output stacker. Holds up to about 50 discs.

m. Lock lever: Use this lever to lock or unlock stacker 4. Lock the lever when you use stacker 3.

n. Stacker 4: Use stacker 4 as a disc output stacker. Holds up to about 5 discs.

o. Stacker 3: Use stacker 3 as a disc output stacker. Holds up to about 50 discs.

p. Printer: Prints on label surface of discs.
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Control Panel

Note: The PP-50II does not have the Stacker 4 light.

Buttons

Lights

Button Function

Cleaning button Press and hold for 3 seconds to clean the print head.

Indicator light Flashing/On Status

Power light

On The power is on. 
When only the Power light is on, the product is on 
standby for data. 

Flashing
Product is being initialized. 
When it flashes rapidly, it is shutting down

Busy light
Flashing Product is processing a job. 

Only for the PP-100III/PP-100AP: When the Busy light is 
flashing rapidly, a disc is being ejected, so do not pull out 
Stacker 4. Discs may be damaged. 

Error light

On
The cover, disc transport system, stacker, drive, or printer 
is experiencing an error. 

Flashing

The unit is experiencing a problem. 
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Note:
The Stacker light flashes when the input stacker is empty; however. the beginning of the light flashing 
may not match the exact time that the stacker becomes empty.

For details on error status, see the following instructions.
& See “Error Indicators” on page 146.

Ink light

On
The ink cartridge has reached its replacement time, the 
ink cartridge is not correctly installed, or incorrect ink 
cartridge is installed.
For information on replacing ink cartridges, see 
“Replacing an Ink Cartridge” on page 128.

Flashing

The ink is low. Obtain a replacement ink cartridge.
Only for the PP-100III/PP-100AP: When all Ink lights flash 
rapidly, the maintenance box has reached its 
replacement time or is not correctly inserted.
For information on replacing maintenance box, see 
“Replacing the Maintenance Box (Only for 
PP-100III/PP-100AP)” on page 142.

Stacker light

On

The stacker is overloaded or full.

Flashing

The stacker is empty or not correctly inserted.

Indicator light Flashing/On Status
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Consumables and Options

To purchase consumables and options, check with the dealer where you purchased your 
product or access either of the following urls:

www.epson-europe.com (Europe)
www.epson.com/support/ (United States and Canada)

Epson also offers the specified CD-R, DVD-R, and BD-R discs for all your writing and printing 
needs.

Product Product name

Ink cartridge Cyan PJIC1(C)

Light Cyan PJIC2(LC)

Light Magenta PJIC3(LM)

Magenta PJIC4(M)

Yellow PJIC5(Y)

Black PJIC6(K)

Maintenance box (for the PP-100III/PP-100AP) PJMB100

Drive (for the PP-100III) BDE-PR1EP
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Technical Specifications

Discs

c
Caution:
Writable/printable discs are 12 cm (4.72”) CD/DVD/BD discs. The 80 mm (3.15”) discs are not 
supported.

Note:
❏ Since the quality of any particular brand or type of disc may be changed by the manufacturer at 

any time, Epson cannot attest to the quality of any brand or type of disc. Always test samples of 
disc stock before purchasing large quantities or printing large jobs.

❏ Poor quality discs may reduce print quality and cause disc jams or other problems. If you 
encounter problems, switch to a higher grade of disc.

❏ The specified disc is for ink jet printers.Thermal transfer discs are not supported.

❏ The specified disc has a moisture adhesive ink receptor layer on the label surface. If stored stacked, 
especially under high humidity and high temperature conditions, discs may adhere to each other. 
If an automatic duplication machine is used, please check the disc before using.

❏ Please treat the recording surface (blue green colored side) and printing surface carefully so they 
do not have fingerprints, dirt, dust, water, or scratches. Dust and dirt on the recording surface 
should be wiped gently with soft dry cloth, commercially available disc cleaner, or ethyl alcohol. 
Do not use benzine, thinner, or antistatic material.

CD/DVD/BD:

Notes for handling discs

Notes when using discs

❏ Do not touch recording surface when holding it. 

❏ Handle with care so that label surface and recording surface do not have fingerprints, dirt, 
dust, water drops, or scratches.

Type CD-R/DVD-R 4.7GB/DVD+R 4.7GB/DVD-R DL 8.5GB/DVD+R DL 8.5GB/
BD-R/BD-R DL

Label side Printable
Glossy labels other than the specified disc type are not supported.

Specified disc CD-R, DVD-R, BD-R
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❏ Do not drop or hit discs.

❏ Do not apply excess force, like pinching with a clip, or bend.

❏ Do not attach an adhesive sticker to the disc. This may result in the disc being unable to 
record or play.

❏ Do not use in a place where lots of dirt and dust are present.

❏ If write and print are performed separately, it is recommended to write before printing.

❏ Leaving discs stacked may result in discs sticking to each other.

❏ Let the discs dry naturally after printing. Touching the surface with your hand or splashing 
the surface with water right after printing may result in blurriness and stickiness.

❏ Printing is possible only on the printing surface. When printing by hand, use a soft-tipped 
writing instrument like a felt pen, and do not use a ballpoint pen. Also, do not erase once 
printed.

❏ The recording surface side has a concentric ring projection called the stack ring. Depending 
on the disc, projection of the stack ring is small and use of such a disc may cause the disc to 
stick before or after printing. It is recommended to check the disc before use. 

❏ The specified discs have a moisture-adhesive ink receptor layer on the label surface. If stored 
stacked, especially under high humidity and high temperature conditions, discs may adhere 
to each other. If an automatic duplication machine is used, please check the disc before 
using.

❏ Only for the PP-100III/PP-50II

❏ Do not use with an auto loading mechanism, a drive with a holding mechanism larger 
than 33 mm, or an automotive drive. Depending on the condition used, the printing 
surfaces may stick.

❏ A published CD/DVD/BD may not be readable on another type of drive or player due to 
compatibility.

Notes when storing discs

❏ Do not store in direct sunlight, near heating equipment, or high humidity and temperature. 

❏ Do not place where large temperature variance takes place, as condensation may occur.

❏ Do not place an object on top of the disc. 
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❏ When storing, keep the disc in its disc case, and avoid letting film or cards touch the printing 
surface. These may scratch the printing surface.

❏ Do not store discs in soft cases or bags which may touch the printing surface directly. This 
may cause discs to stick; may cause color shading or discoloration.

❏ Avoid storing with part of the printing surface covered, as this may cause smearing or 
discoloration.

❏ Making a backup is recommended if the data is important. It is recommended to make 
backups periodically if storing for long period of time.

❏ Avoid storing in high temperatures and high humidity, which may result in blurriness and 
stickiness of the printing surface.

Printable area

The printable area is the area available for label printing.
The printable area can be set from the Set Inner/Outer Diameter screen of EPSON Total Disc 
Maker.
In the Set Inner/Outer Diameter screen, you can select Standard, Wide, or set manually.
The following diagram shows the printable area for Standard and Wide. Printing will be done in 
the gray area.

CD/DVD/BD:

12-cm (4.72") CD/DVD/BD (Standard) 12-cm (4.72") CD/DVD/BD (Wide)

Inner diameter Outer diameter Inner diameter Outer diameter

45 mm (1.77") 116 mm (4.57") 25.5 mm (1.00") 116 mm (4.57")
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c
Caution:
❏ Make sure to set the inner diameter and the outer diameter within the areas shown above. 

Printing on sections outside the printable area may damage your CD/DVD/BD drive.

❏ The EPSON Total Disc Maker can be set between an inner diameter of 18 mm and an outer 
diameter of 119.4 mm (0.71 to 4.70"). However, printing outside the printable area (45 to 
116 mm) may result in sticking, staining of the disc tray, peeling of print, and blurring of 
print. It is recommended to check the disc type before using.

❏ When printing outside the printable area (ink absorbing layer) of the disc occurs, the ink 
printed outside the printable area does not fix. Check the label of the printable area of the 
disc being used before setting.

❏ Precautions for setting the printable area
-Make sure the printable area set does not exceed the printable area of the actual disc being 
used.
-Check whether coloration of print made on the rib (stack ring) is not uniform.
-Printing on the rib (stack ring) may cause ink sticking, disc sticking, and ink erasure after 
printing.

❏ Measures to be taken when printing outside printable area:
When printing inside the inner diameter results in ink sticking, disc sticking, and ink erasure, 
take the following action to avoid that.
-Set Drying Time on the printer driver’s printer settings screen and print. Although 
throughput may be reduced, problems will be avoided or reduced, since the disc will be 
ejected after a set time.
-Enable Mask Rib Area. If you print from another application, set from the user-defined label 
setting in the printer driver. If you print from the Total Disc Maker, set from Set Inner/Outer 
Diameter setting.

Note:
When you print on discs with a commercially available software package that supports disc printing, 
you have to make the following settings.

Size 124 x 124 mm (4.88 x 4.88")

Type CD/DVD Label, CD/DVD Premium Label, or Epson Specified 
CD/DVD Label

Margins on all sides 2 mm (0.08")
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Ink Cartridges

c
Caution:
❏ Epson recommends the use of genuine Epson ink cartridges. Other products not 

manufactured by Epson may cause damage that is not covered by Epson’s warranties, and 
under certain circumstances, may cause erratic behavior.

❏ Use the ink cartridge before the expiration date printed on its package.

❏ Do not refill the ink cartridge. Other products not manufactured by Epson may cause 
damage that is not covered by Epson's warranties, and under certain circumstances, may 
cause erratic behavior.

Note:
❏ The ink cartridges packaged with your product are partly used during initial setup. In order to 

produce high-quality printouts, the print head in your product will be fully charged with ink. This 
one-off process consumes a quantity of ink, and therefore these cartridges print fewer pages 
compared to subsequent ink cartridges.

❏ Do not store ink cartridges in high or freezing temperatures, or in direct sunlight.

❏ To ensure that you receive premium print quality and to help protect your print head, a variable 
ink safety reserve remains in the cartridge when your product indicates to replace the cartridge. 
The yields quoted for you do not include this reserve.

❏ Cartridge yields vary considerably based on images printed, print settings, disc type, frequency of 
use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the 
"replace cartridge" indicator comes on. This product ships with full cartridges and part of the ink 
from the first cartridges is used for priming its printer. See www.discproducer.epson.com for more 
information about cartridges.

❏ Even when Black is selected for Print Mode Setting, all the ink colors are used in an operation 
designed to maintain the printing and print head quality.

Color Black, Yellow, Magenta, Light Magenta, Cyan, Light Cyan

Cartridge life Use within 6 months of opening the package.

Temperature Storage:
-20 to 40 °C (-4 to 104 °F) 
1 month at 40 °C (104 °F)
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Job Processing

Note:
❏ Job processing speed differs depending on the environment.

❏ Only for the PP-100III/PP-50II: Depending on the disc or the computer used, writing speed may 
become slower than the set speed.

PP-100III

PP-50II

Job 
processing 
speed

Write and 
print

CD 30 discs/hr
When using Epson specified CD-R, drive 
speed of 40x, writing 600 MB data, and 
Speed/Bidirectional printing.

DVD 15 discs/hr
When using Epson specified DVD-R, drive 
speed of 12x, writing 3.8 GB data, and 
Speed/Bidirectional printing.

BD 8.5 discs/hr
When using Epson specified BD-R, drive 
speed of 8x, writing 23.8 GB data, and 
Speed/Bidirectional printing.

Print only Quality/Speed: [2] 65 discs/hr
Bidirectional printing

Quality/Speed: [1] 45 discs/hr
Bidirectional printing

Printing direction Bidirectional, unidirectional

Job processing speed
(Write and print)

CD 15 discs/hr
When using Epson specified CD-R, drive 
speed of 40x, writing 600 MB data, and 
Speed/Bidirectional printing.

DVD 8 discs/hr
When using Epson specified DVD-R, drive 
speed of 12x, writing 3.8 GB data, and 
Speed/Bidirectional printing.

BD 3 discs/hr
When using Epson specified BD-R, drive 
speed of 6x, writing 23.8 GB data, and 
Speed/Bidirectional printing.

Printing direction Bidirectional, unidirectional
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PP-100AP

Number of Products that can be Connected to One Computer

For the PP-50II, you cannot connect more than one product to one computer.

PP-100III

*: Guaranteed number of products that can process jobs published from one connected PC at the same 
time.

PP-100AP

*: Guaranteed number of products that can process jobs published from one connected PC at the same 
time.

Printing

dpi: number of dots every 25.4 mm (dots per inch)

*: Available for the PP-100AP only.

Job processing speed
(during bidirectional 
printing)

Print Mode Setting
(Quality/Speed)

[1]: 50 discs/hr
[2]: 75 discs/hr
[3]: 95 discs/hr

Printing direction Bidirectional, unidirectional

Number of products that can 
be connected to one 
computer*

Write and print CD 3

DVD/BD 2

Print only 6

Number of products that can 
be connected to one 
computer*

6

Printing method On demand inkjet

Head Number of nozzles 180 per color

Resolution Print Mode Setting 
(Quality/Speed)

[1]: 1,440 x 1,440 dpi

[2]: 1,440 x 720 dpi

[3]*: 720 x 720 dpi
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Write Speed (Only for PP-100III/PP-50II)

*1: If you select 2.4x for DVD-R/DVD-R DL, write speed will be set to 2x.

*2: If you select 2x for DVD+R/DVD+R DL, write speed will be set to 2.4x.

*3: 8x write speed is possible only when Epson BDs specified for 8x write speed are used.

Note:
Depending on the disc or the computer used, writing speed may become slower than the set speed.

Mechanical

CD-R 40x / 32x / 24x /16x / 10x / 4x

DVD-R 12x / 8x / 6x / 4x / 2.4x*1 / 2x

DVD+R 12x / 8x / 6x / 4x / 2.4x / 2x*2

DVD-R DL 8x / 6x / 4x / 2.4x*1/ 2x

DVD+R DL 8x / 6x / 4x / 2.4x/ 2x*2

BD-R 8x*3 / 6x / 4x / 2x

BD-R DL 8x*3 / 6x / 4x / 2x

PP-100III PP-50II PP-100AP

Drive Two drives, tray loading type -

Stacker capacity Stackers 1 to 3: 
Max. about 50 discs
Stacker 4: 
Max. about 5 discs

Stackers 1 and 2: 
Max. about 50 discs
Stacker 3: 
Max. about 20 discs

Stackers 1 to 3: 
Max. about 50 discs
Stacker 4: 
Max. about 5 discs

Dimensions Width: 
377 mm (14.8 inches)
Depth: 
493 mm (19.4 inches)
Height: 
348 mm (13.7 inches)

Width: 
377 mm (14.8 inches)
Depth: 
465 mm (18.3 inches)
Height: 
324 mm (12.8 inches)

Width: 
377 mm (14.8 inches)
Depth: 
489 mm (19.3 inches)
Height: 
348 mm (13.7 inches)

Weight
(including the 
stackers and ink 
cartridges, but not 
including the power 
cord and discs)

Approx. 24 kg (53 lb) Approx. 21 kg (46 lb) Approx. 22 kg (48.5 lb)
Product Information 190



Electrical

Note:
Check the label on the back of the product for its voltage.

Environmental

*: Without condensation

Interface

PP-100III PP-50II PP-100AP

Input voltage range AC 100 to 240 V

Rated frequency range 50 to 60 Hz

Rated current 1.0 A

Power 
consumption

Operating Approx. 52 W Approx. 40 W Approx. 30 W

Standby mode Approx. 27 W Approx. 28 W Approx. 20 W

Temperature Operation:
10 to 35 °C (50 to 95 °F)
Storage: 
-20 to 40 °C (-4 to 104 °F)
1 month at 40 °C (104 °F)

Humidity Operation:* 
20 to 80% RH
Storage:*
5 to 85% RH

Elevation 2000 m or less

PP-100III PP-50II PP-100AP

Compliance USB 3.0/USB 2.0 USB 2.0

Communication 
speed

Super-Speed (5 Gbps)
Hi-Speed (480 Mbps)

Hi-Speed (480 Mbps)
Full-Speed (12 Mbps)
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Lifetime

PP-100III

*1: With bidirectional printing

*2: Based on printing 3,000 discs per month

PP-50II

*: With bidirectional printing

PP-100AP

*1: With bidirectional printing

*2: Based on printing 3,000 discs per month

Lifetime 5 years after purchase or until 75,000 discs*1 have been 
published, whichever is shorter.

Maintenance 
parts

Drive
(for one unit)

Whichever is shorter from the following:
❏ Opening and closing of the drive tray: 30,000 times
❏ Write time: 1,000 hours (CD only: 500 hours, DVD only: 

500 hours, BD only: 1,000 hours)
❏ Read/write time: 2,000 hours (including comparison)

Maintenance box Replacement is required after printing every 30,000*2 discs. 
However, this number may be less if head cleaning is 
performed more often than necessary.

Auto loader unit Replacement is required after printing every 75,000 discs.

Lifetime 5 years after purchase or until 15,000 discs* have been 
published, whichever is shorter.

Lifetime 5 years after purchase or until 100,000 discs*1 have been 
published, whichever is shorter.
Replacing maintenance parts allows you to print up to 
300,000 discs.

Maintenance 
parts

Maintenance box Replacement is required after printing every 30,000*2 discs. 
However, this number may be less if head cleaning is 
performed more often than necessary.

Auto loader unit Replacement is required after printing every 100,000 discs.

Mechanical unit Replacement is required after printing every 150,000*1 discs.
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